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Hinweise zur Dokumentation Kapitel: Anderungsindex

0 Anderungsindex

Version Anderungen
0.1 erste Vorabversion
0.2 BIOS-Einstellungen aktualisiert
0.3 BIOS-Einstellungen aktualisiert
0.4 Kapitel 3.5.1 Hinweis ergénzt
0.5 Kapitel 3.4.9 aktualisiert;
Kapitel 3.2.6 LAN Pinbelegung korrigiert

L HINWEIS

Alle in diesem Handbuch erwéhnten Firmennamen und Produktbezeichnungen sind als eingetragene oder
nicht eingetragene Marken Eigentum ihrer jeweiligen Inhaber und als solche national und international
markenrechtlich geschitzt.
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Kapitel: Einleitende Hinweise Hinweise zur Dokumentation

1 Einleitende Hinweise

1.1 Hinweise zur Dokumentation

Diese Beschreibung wendet sich ausschlie3lich an ausgebildetes Fachpersonal der Steuerungs- und
Automatisierungstechnik, das mit den geltenden nationalen Normen vertraut ist. Zur Installation und
Inbetriebnahme der Komponenten ist die Beachtung der nachfolgenden Hinweise und Erklarungen
unbedingt notwendig.

1.1.1 Haftungsbedingungen

Das Fachpersonal hat sicherzustellen, dass die Anwendung bzw. der Einsatz der beschriebenen Produkte
alle Sicherheitsanforderungen, einschlie3lich samtlicher anwendbarer Gesetze, Vorschriften,
Bestimmungen und Normen erfullt.

Die Dokumentation wurde sorgfaltig erstellt. Die beschriebenen Produkte werden jedoch standig
weiterentwickelt. Deshalb ist die Dokumentation nicht in jedem Fall vollstandig auf die Ubereinstimmung mit
den beschriebenen Leistungsdaten, Normen oder sonstigen Merkmalen geprift. Keine der in diesem
Handbuch enthaltenen Erklarungen stellt eine Garantie im Sinne von 8§ 443 BGB oder eine Angabe Uber die
nach dem Vertrag vorausgesetzte Verwendung im Sinne von 8 434 Abs. 1 Satz 1 Nr. 1 BGB dar. Falls sie
technische Fehler oder Schreibfehler enthalt, behalten wir uns das Recht vor, Anderungen jederzeit und
ohne Ankiindigung durchzufihren. Aus den Angaben, Abbildungen und Beschreibungen in dieser
Dokumentation kénnen keine Anspriiche auf Anderung bereits gelieferter Produkte gemacht werden.

1.1.2 Copyright

© Diese Dokumentation ist urheberrechtlich geschitzt. Jede Wiedergabe oder Drittverwendung dieser
Publikation, ganz oder auszugsweise, ist ohne schriftliche Erlaubnis der Beckhoff Automation GmbH
verboten.

Seite 8 Beckhoff New Automation Technology CB1056



Sicherheitshinweise Kapitel: Einleitende Hinweise

1.2 Sicherheitshinweise

Beachten Sie bitte die folgenden Sicherheitshinweise und Erklarungen! Produktspezifische
Sicherheitshinweise finden Sie auf den folgenden Seiten oder in den Bereichen Montage, Verdrahtung,
Inbetriebnahme usw.

1.2.1 Auslieferungszustand

Die gesamten Komponenten werden je nach Anwendungsbestimmungen in bestimmten Hard- und
Software-Konfigurationen ausgeliefert. Anderungen der Hard- oder Software-Konfiguration, die tiber die
dokumentierten Moglichkeiten hinausgehen, sind unzuléssig und bewirken den Haftungsausschluss der
Beckhoff Automation GmbH.

1.2.2 Erklarung der Sicherheitssymbole

In der vorliegenden Dokumentation werden die folgenden Sicherheitssymbole verwendet. Diese Symbole
sollen den Leser vor allem auf den Text des darunter stehenden Sicherheitshinweises aufmerksam
machen Dieser Sicherheitshinweis ist aufmerksam zu lesen und unbedingt zu befolgen.

A AKUTE VERLETZUNGSGEFAHR!

Wenn der Sicherheitshinweis unter diesem Symbol nicht beachtet wird, besteht unmittelbare Gefahr fr
Leben und Gesundheit von Personen.

A VORSICHT, VERLETZUNGSGEFAHR!

Wenn der Sicherheitshinweis unter diesem Symbol nicht beachtet wird, besteht Gefahr fir Leben und
Gesundheit von Personen.

A GEFAHR FUR PERSONEN, UMWELT, GERATE ODER DATEN!

Wenn der Sicherheitshinweis unter diesem Symbol nicht beachtet wird, kénnen Personen, Umwelt oder
Gerate geschadigt oder Daten geldscht werden.

' HINWEIS, TIPP ODER FINGERZEIG

Dieses Symbol kennzeichnet Informationen, die zum besseren Verstandnis beitragen.

Beckhoff New Automation Technology CB1056 Seite 9



Kapitel: Einleitende Hinweise Grundlegende Sicherheitsmal3nahmen

1.3 Grundlegende SicherheitsmalRBhahmen

1.3.1 Sorgfaltspflicht des Betreibers
Der Betreiber muss sicherstellen, dass

o das Produkt nur bestimmungsgemalf verwendet wird.

o das Produkt nur in einwandfreiem, funktionstiichtigem Zustand betrieben wird.

o die Betriebsanleitung stets in einem leserlichen Zustand und vollstdndig am Einsatzort des Produkts
zur Verfligung steht.

o nur ausreichend qualifiziertes und autorisiertes Personal das Produkt bedient.

o dieses Personal regelmafig in allen zutreffenden Fragen von Arbeitssicherheit und Umweltschutz
unterwiesen wird, sowie die Betriebsanleitung und insbesondere die darin enthaltenen
Sicherheitshinweise kennt.

1.3.2 Nationale Vorschriften je nach Maschinentyp

Je nach Maschinen- und Anlagentyp, in dem das Produkt zum Einsatz kommt, bestehen nationale
Vorschriften fir Steuerungen solcher Maschinen und Anlagen, die der Betreiber einhalten muss. Diese
Vorschriften regeln unter anderem, in welchen Zeitabstéanden die Steuerung Uberprift werden muss. Der
Betreiber muss diese Uberpriifung rechtzeitig veranlassen.

1.3.3 Anforderungen an das Bedienungspersonal

o Betriebsanleitung lesen: Jeder Benutzer des Produkts muss die Betriebsanleitung fir die Anlage, an
der er eingesetzt wird, gelesen haben.
o Systemkenntnisse: Jeder Benutzer muss alle fur ihn erreichbaren Funktionen des Produkts kennen.

Seite 10 Beckhoff New Automation Technology CB1056



Funktionsumfang Kapitel: Einleitende Hinweise

1.4 Funktionsumfang

L HINWEIS

Die in der vorliegenden Dokumentation enthaltenen Beschreibungen stellen eine umfassende
Produktbeschreibung dar. Soweit das beschriebene Motherboard als Bestandteil eines Industrie-PC der
Beckhoff Automation GmbH erworben worden ist, findet die hierin enthaltene Produktbeschreibung nur in
eingeschranktem Umfang Anwendung. Maf3geblich sind die vereinbarten Spezifikationen des
entsprechenden Industrie-PC der Beckhoff Automation GmbH. Durch verschiedene Bauformen der
Industrie-PC kann es zu Abweichungen in der Bauteilbestiickung des Motherboards kommen. Support-
und Serviceleistungen der Beckhoff Automation GmbH fir das eingebaute Motherboard erstrecken sich
ausschlieBlich auf die Produktbeschreibung einschlieRlich Betriebssystem des jeweiligen Industrie-PC.

Beckhoff New Automation Technology CB1056 Seite 11



Kapitel: Ubersicht Eigenschaften

2 Ubersicht

2.1 Eigenschaften

Das CB1056 ist ein Industrie-Motherboard im ATX-Formfaktor, das auf Intels® QM67 PCH Chipsatz beruht
und auf dem aktuelle Intel®-CPUs der Core™- und Celeron®-Serien (2. Generation) eingesetzt werden
konnen. Uber seine zwei SO-DIMM204-Steckplatze kann es mit bis zu 16 GByte
DDR3-1066/1333/1600-Speicher ausgestattet werden. Mit drei PCI-, zwei PCleX1, einem PCleX4 und
einem PCleX16-Steckplatz bietet das Board umfangreiche Erweiterungsmdoglichkeiten. Eine Vielzahl von
internen und externen Anschliissen machen das CB1056 zu einem sehr universell einsetzbaren
Motherboard. Vier serielle Schnittstellen, zwei Gigabit-LAN-Anschlisse, diverse analoge und digitale
Ton-Ein- und -Ausgénge, 14 USB-Schnittstellen, DVI/HDMI-, CRT-, LCD- und DisplayPort-Anschluss
sowie sechs SATA-Anschlisse (zwei davon 6G-féhig) lassen keine Wiinsche mehr offen.

Power VCCCore; VTT;
DDRVTT, GFXVCC :

1,05V; 1,5V; 1,8V; 3,3V Intel® Core™ i7- 2x SO-DIMM204

2710QE, i5-2510E, MEMORY DDR3-1600

Celeron® B810 (dual channel)

PCle x16 < PCle (PEG)

i

SMBus

CRT )
DVI/HDMI —— SPDIFi
DVI/HDMI —— SPDIF o
DP RealTek® —— LINEIN
LVDS 1812413614 Intel® QM67 PCH HDA Link ALC889 —— LINEOUT
— —— MIC
USB1-14 USB 2.0 —r— CDIN

Intel®
LAN1 825791 1.5/3/6 GBls————— 2X SATA
T /ﬂ 151368 4x SATA
< o PCle to PCI PCie
Bridge
iL PI7COX111SL i

e SMSC® pj 5 Intel®
SCH3114 82574L

FAN 1-4 —
COM1-4 ——
8x GPIO —|—

PCI Slot 1

PCI Slot 2

PCI Slot 3

LAN2 ——

PCle x4 Slot 1
PCle x1 Slot 2
PCle x1 Slot 3

(n/aif x4 dev. in sl. 1)

Sockel rPGA988B

Fur CPUs: Intel® Core™ i7-2710QE, i5-2510E, Celeron® B810
Chipsatz Intel® QM67 PCH

Zwei SO-DIMM204-Steckplatze fir bis zu 16 GByte DDR3-1066/1333/1600
Drei PCI-Steckplatze

Zwei PCle-Steckplatze x1

Ein PCle-Steckplatz x4

Ein PCle-Steckplatz x16

Vier serielle Schnittstellen COM1 bis COM4

Zwei LAN-Anschliisse Ethernet 10/100/1000 (Base-T)

Sechs SATA-Anschlisse

PS2-Keyboard- und -Maus-Schnittstelle

14 USB-2.0-Schnittstellen

O 0 0O OO O0OO0OO0OO0OO0oOO0oOOoOOo
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Eigenschaften Kapitel: Ubersicht

AMI Aptio BIOS

1x DVI-I

1x DVI-D, 1x intern HDMI (nicht gleichzeitig nutzbar)
CRT-Anschluss

TFT-Anschluss Uber LVDS 18/24/36/48

HDA-kompatible Soundausgabe mit SPDIF-Ein- und -Ausgang
8x GPIO

RTC mit externer CMOS-Batterie

ATX-Spannungsversorgung inkl. 2x2pin-12V-Stecker

Format: ATX (305mm x 220mm)

O 0O O O O O O OO0 O0
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Kapitel: Ubersicht Spezifikationen und Dokumente

2.2 Spezifikationen und Dokumente

Fur die Erstellung dieses Handbuchs bzw. als weiterfihrende technische Dokumentation wurden die
folgenden Dokumente, Spezifikationen oder Internetseiten verwendet.

= ATX-Spezifikation
Version 2.2
www.formfactors.com

=  PCI-Spezifikation
Version 2.3 bzw. 3.0
WWW.PCIisig.com

= PCI Express® Base Specification
Version 2.0
WWW.pcisig.com

= ACPI-Spezifikation
Version 3.0
www.acpi.info

=  ATA/ATAPI-Spezifikation
Version 7 Rev. 1
www.t13.0rg

= USB-Spezifikationen
www.usb.org

=  SM-Bus-Spezifikation
Version 2.0
www.smbus.org

= Intel®-Chipsatzbeschreibung
Intel® 6 Series Chipset datasheet
www.intel.com

= Intel®-Chipbeschreibungen
2nd Gen. Intel® Core™ Processor Family Mobile datasheet
www.intel.com

= Intel®-Chipbeschreibung
82579L Datasheet
www.intel.com

= Intel®-Chipbeschreibung
825741 Datasheet
www.intel.com

=  SMSC®-Chipbeschreibung
SCH3114 Datasheet
WWW.SmMSc.com
(NDA erforderlich)

= Realtek® Chip Description
ALC885/889 Datasheet
www.realtek.com.tw

= ICS® Chipbeschreibung
ICS9LPRS501 Datasheet
www.idt.com

=  American Megatrends®
Aptio™ Text Setup Environment (TSE) User Manual
www.ami.com
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Spezifikationen und Dokumente Kapitel: Ubersicht

= American Megatrends®
Aptio™ 4 x Status Codes
www.ami.com
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Kapitel: Anschliisse Spezifikationen und Dokumente

3 Anschlusse

Auf den folgenden Seiten werden samtliche Steckverbinder auf dem CB1056 beschrieben.

A ACHTUNG

Die verwendeten Kabel missen fir die meisten Schnittstellen bestimmten Anforderungen gentigen. Fur
eine zuverlassige USB-2.0-Verbindung sind beispielsweise verdrillte und geschirmte Kabel notwendig.
Einschrankungen bei der maximalen Kabellange sind auch nicht selten. Samtliche dieser
schnittstellenspezifischen Erfordernisse sind den jeweiligen Spezifikationen zu entnehmen und
entsprechend zu beachten.

Seite 16 Beckhoff New Automation Technology CB1056



Stromversorgung, Systemanschliusse, CPU

Kapitel: Anschlisse

3.1 Stromversorgung, Systemanschlisse, CPU

3.1.1 Stromversorgung

Der Anschluss fiur die Stromversorgung ist als 2x10-poliger Standard-ATX-Stecker ("ATX20", Foxconn
HM3510E-P2) realisiert. Dieser wird erganzt durch einen eigenen 2x2-poligen Gehausestecker, tiber den

die COREIN-Spannung zu Verfiigung gestellt werden muss.

ATX Power

1 P1800
&

10

11

20

Pinbelegung "ATX20"-Stromstecker:

| 'E"Ii
2 = o
()
2 1
13 |
H
[ I
3 }
=
a0
“ 3
()
H O
. !
Tl s fp
arme S ) " . i
U X o,

Beschreibung Name Pin Name Beschreibung
Versorgungsspannung 3,3V [3,3V 1 11 3,3V Versorgungsspannung 3,3V
Versorgungsspannung 3,3V |3,3V 2 12 -12V Versorgungsspannung -12V
Masse GND 3 13 GND Masse
Versorgungsspannung 5V VCC 4 14 PWRBTN# |Powerbutton
Masse GND 5 15 GND Masse
Versorgungsspannung 5V VCC 6 16 GND Masse
Masse GND I 17 GND Masse
Stromversorgung an PWR_ON 8 18 -5V Versorgungsspannung -5V
Standby 5V SVCC 9 19 VCC Versorgungsspannung 5V
Versorgungsspannung 12V |12V 10 20 VCC Versorgungsspannung 5V

Beckhoff New Automation Technology CB1056
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Kapitel: Anschliisse Stromversorgung, Systemanschliisse, CPU

Core Power
P1801

N0 BES

Pinbelegung ATX-Powerstecker 2x2:

Beschreibung Name Pin Name Beschreibung
Masse GND 1 3 COREIN Versorgungsspannung 12V
Masse GND 2 4 COREIN Versorgungsspannung 12V

Seite 18 Beckhoff New Automation Technology CB1056



Stromversorgung, Systemanschliusse, CPU

Kapitel: Anschlisse

3.1.2 System

Das Board verfiigt Uber eine 2x13-polige Standardstiftleiste flr Schneidklemmtechnik im Rastermal3
2,54mm, Uber die die Signale flr Powerbutton, Reset, Tastaturlock, IrDA und diverse Status-LEDs zur

Verfigung gestellt werden.

System 1

B1 P1505

A1

B13

A13

Pinbelegung Stiftleiste "System 1"

Beschreibung Name Pin Name Beschreibung
On/Suspend-Taste PWRBTN# (Al Bl GND Masse
Masse GND A2 B2 KBLOCK Tastaturlock
Reserviert N/C A3 B3 PWLED# Power-LED
Masse GND A4 B4 N/C Reserviert
Versorgungsspannung 5V VCC A5 B5 PWLED Versorgungsspannung 3,3V
Festplatten-LED HDLED# A6 B6 N/C Reserviert
Versorgungsspannung 5V VCC A7 B7 VCC Versorgungsspannung 5V
Reserviert N/C A8 B8 GND Masse
IrDA Senden IRTX A9 B9 N/C Reserviert
Masse GND Al0 B10 BEEP Lautsprecher
IrDA Empfangen IRRX All B11 N/C Reserviert
IrDA Kontrollsignal CIRRX Al2 B12 GND Masse
Versorgungsspannung 5V VCC Al3 B13 RESET# Reset

Beckhoff New Automation Technology CB1056
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3.1.3 CPU-Sockel

Das CB1056-Board ist mit einem rPGA988B-CPU-Sockel ausgestattet, in den bestimmte CPUs aus
Intels® "2nd Generation Core™ Architecture"-Reihe eingesetzt werden kénnen.. Es handelt sich um einen
ZIF-Sockel, in den der Prozessor eingelegt und anschlieRend mit der Feststellschraube arretiert wird. Die
CPU passt nur in einer von vier moglichen Orientierungen in den Sockel.

L HINWEIS

Das Board wird standardmafig ohne Prozessor ausgeliefert. Prozessoren missen gesondert bestellt
werden.

CPU Socket rPGA988B

I00CO000000000ODO0O0V0O000)
0000000000000 0A0O0O0O0Q0Q0
ROQ00000OVQ0O000QVO0O00000)
0COCO000000000000000TOO000
IRQOCOVOQOROOO0ODQVOOIDVOO0)
0000000000000 000000000Q0Q0),
QOO0 000000
OOO000| 000000
00000 QOO00QC
QCOO00| Q00000
00000 QOO0
Q0000 Q00000
0O0000) Q00000
000000 Q00000
OO0000! OO00Q0
00000 Q00000
000000 000000
QOQO00! QOO0
OCO000 000000
00QO00L_________________JOO00Q0
QOOOOCO0000000000ODD0O0O000
0000000000000 O0ACCO00Q0
0O0000000000000000000000Q0!
0000000000DA0A0Q0Q0A0A0O!
0OOOOCO000QCO0OOODOCOOVOO0
D0000000000000000000000Q0,
U100
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3.1.4 CMOS-Batterie

Das Board wird mit einem CR2032-Batteriehalter (Renata VBH2032-1) samt 3V-Batterie ausgeliefert, kann
aber auBerdem Uber einen zweipoligen Gehausestecker (JST B2B-EH-A, passender Gegenstecker:
EHR-2) an eine externe Batterie angeschlossen werden, um die integrierte Uhr auch bei Wegfall der
Versorgungsspannung weiter zu versorgen.

Batt. Holder

ext. Batt.

BT1800

Pinbelegung Batteriestecker:

Pin Name

Beschreibung

1 BATT

3,3V Batteriespannung

2 GND

Masse

Beckhoff New Automation Technology CB1056
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3.2 Anschlisse Ruckwandblech

Das Board verfiigt uber diverse Standardanschlisse fir externe Gerate, wie PS/2-Tastatur und -Maus,
Bildschirme, Lautprecher, Mikrofon, LAN, USB usw. Diese Anschlisse befinden sich in der von der
ATX-Spezifikation vorgegebenen "I/O Connector Area" (maximal 37mm x 152mm auf dem Gehéauseblech),
so dass sie in einem normalen ATX-Gehause im gewohnten Bereich auf der Riickseite vorzufinden sind.

3.2.1 DVI-Stecker

Das CB1056 verfugt tUber einen DVI-I- und einen DVI-D-Stecker in einem Kombibauteil (Foxconn
QH11121-DADF-4F). Am DVI-I-Stecker kann tber einen Adapter ein analoger CRT-Monitor
angeschlossen werden. Digitale DVI- oder HDMI-Displays kénnen an beiden beiden Steckern
angeschlossen werden. Die CPU-Grafik unterstitzt maximal zwei unabhangige Displays.

1 8 C1C2 E.,
ENEEEEEE ., 2
9 ENNENNEEN —= C5 =
EEEEEEER ;
17 P1400A 24 C3C4 Ef
1 plaos 8 é
EEEEEEER 5
9 EEEEEEEN — C5

EENEEEEER
17 24

Pinbelegung DVI-I:

Pin Name Beschreibung

1 TMDSDAT2# DVI-Daten 2 -

2 TMDSDAT?2 DVI-Daten 2 +

3 GND Masse

4 N/C Reserviert

5 N/C Reserviert

6 DDC CLK DDC Clock (DVI/VGA)

7 DDC DAT DDC Data (DVI/VGA)

8 VSYNC VGA Vertikaler Sync

9 TMDSDAT1# DVI-Daten 1 -

10 |[TMDSDAT1 DVI-Daten 1 +

11 |GND Masse

12 |N/C Reserviert

13  |N/C Reserviert

14 |VCC Versorgungsspannung 5V

15 |GND Masse

16 |HP_DETECT |Hot Plug Detect

17 |TMDSDATO# |DVI-Daten O -

18 |TMDSDATO DVI-Daten 0 +

19 |[GND Masse

20 |N/C Reserviert
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Pin Name Beschreibung
21 |N/C Reserviert
22 |GND Masse
23 |TMDS CLK DVI-Clock
24 |TMDS CLK# DVI-Clock
Cl |RED VGA Rot
C2 |GREEN VGA Griin
C3 |BLUE VGA Blau
C4 |HSYNC VGA Horizontaler Sync
C5 |GND Masse
Pinbelegung DVI-D:
Pin Name Beschreibung
1 TMDSDAT2# |DVI-Daten 2 -
2 TMDSDAT2 DVI-Daten 2 +
3 GND Masse
4 N/C Reserviert
5 N/C Reserviert
6 DDC CLK DDC Clock (DVI/VGA)
7 DDC DAT DDC Data (DVI/VGA)
8 N/C Reserviert
9 TMDSDATI1# |[DVI-Daten 1 -
10 |TMDSDAT1 DVI-Daten 1 +
11 |GND Masse
12 |N/C Reserviert
13 |N/C Reserviert
14 |vCC Versorgungsspannung 5V
15 |GND Masse
16 [HP DETECT |Hot Plug Detect
17 |TMDSDATO# |DVI-Daten O -
18 |TMDSDATO DVI-Daten 0 +
19 |GND Masse
20 |N/C Reserviert
21 |N/C Reserviert
22 |GND Masse
23 TMDS CLK DVI-Clock
24 TMDS CLK# DVI-Clock
Cl |[N/C Reserviert
C2 |N/C Reserviert
C3 |[N/C Reserviert
C4 |[N/C Reserviert
C5 |GND Masse

Beckhoff New Automation Technology CB1056
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3.2.2 DVI/HDMI

Das CB1056 verfligt noch tber einen weiteren DVI-Anschluss, der als 2x9poliger Wannenstecker realisiert
ist (Molex 87831-1820, passender Gegenstecker z.B. Molex 0791098658-ND). Analoge VGA-Signale
liegen an diesem Anschluss nicht an, es kann aber ein HDMI-Bildschirm angeschlossen werden. Dieser
Anschluss und der DVI-D-Anschluss kénnen nicht gleichzeitig benutzt werden.

Pinbelegung 2x9-Wannenstecker DVI/HDMI:

Beschreibung Name Pin Name Beschreibung
HDMI Panel angeschlossen [HPD_SINK |1 2 N/C Reserviert
SMBus Clock (DDC) SCL_SINK |3 4 SDA_SINK |SMBus Dat (DDC)
Versorgungsspannung 5V VCC 5 6 GND Masse
Masse GND 7 8 TMDS_CLK#|DVI Clock -
DVI Data O - TMDS_DO0# |9 10 TMDS_CLK |DVI Clock +
DVI Data 0 + TMDS DO |11 12 GND Masse
Masse GND 13 14 TMDS_D1# |DVIData 1l -
DVI Data 2 - TMDS_D2# |15 16 TMDS D1 [DVIDatal +
DVI Data 2 + TMDS D2 |17 18 GND Masse
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3.2.3 Display Port

Fur Gerate mit DisplayPort-Anschluss steht ein entsprechender Stecker zur Verfiigung (Foxconn

3vD11207-H7AB-4H).

Pinbelegung des DisplayPort-Steckers:

Beschreibung Name Pin Name Beschreibung
Displayport Lane 0 + DPLO 1 2 GND Masse
Displayport Lane O - DPLO# 3 4 DPL1 Displayport Lane 1 +
Masse GND 5 6 DPL1# Displayport Lane 1 -
Displayport Lane 2 + DPL2 7 8 GND Masse
Displayport Lane 2 - DPL2# 9 10 DPL3 Displayport Lane 3 +
Masse GND 11 12 DPL3# Displayport Lane 3 -
Masse GND 13 14 GND Masse
Displayport Aux + DPAUX 15 16 GND Masse
Displayport Aux - DPAUX# 17 18 HPD Hotplug Detect
Masse GND 19 20 3.3V Versorgungsspannung 3,3V

Beckhoff New Automation Technology CB1056
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Anschlisse Rickwandblech

3.2.4 PS/2-Maus und -Tastatur

PS/2-Mause und -Tastaturen kénnen lber Standard-MiniDIN-Stecker angeschlossen werden. Die
Spannungsversorgung dieser Komponenten kann neben der normalen Versorgung (VCC) auch Uber die
Standby-Spannung (SVCC) erfolgen, so dass das Board mit der Maus oder der Tastatur aus dem Standby-
oder Suspend-Modus aufgeweckt werden kann. Um diese Mdglichkeit zu aktivieren, muss der
KBPWR-Jumper entsprechend gesetzt werden (Seite 51). AuBerdem mussen im BIOS-Setup die nétigen
Einstellungen vorgenommen werden.

PS/2 Mouse

PS/2 Keyboard

Pinbelegung "PS/2 Mouse":

N\ ]

Beschreibung Name Pin Name Beschreibung
Mouse Data MDAT Bl B2 N/C Reserviert
Masse GND B3 B4 (S)vCceC Versorgungsspannung 5V
Mouse Clock MCLK B5 B6 N/C Reserviert
Pinbelegung "PS/2 Keyboard":

Beschreibung Name Pin Name Beschreibung
Keyboard Data KDAT Al A2 MDAT Mouse Data
Masse GND A3 A4 (S)vCceC Versorgungsspannung 5V
Keyboard Clock KCLK A5 A6 MCLK Mouse Clock

Seite 26
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3.2.5 Serielle Schnittstelle COM1

Die serielle Schnittstelle COML1 ist Uiber einen 9-poligen Standard-DSUB-Stecker (male, z.B. Foxconn
DM10152-H5W3-4F) herausgefihrt. Die Signale entsprechen der RS232-Norm.
Die Port-Adresse und der benutzte Interrupt werden mit Hilfe des BIOS-Setup eingestellt.

7 pis0

Pinbelegung der seriellen Schnittstelle (DSUB-Stecker):

Beschreibung Name Pin Name Beschreibung
Data Carrier Detect DCD 1 6 DSR Data Set Ready
Receive Data RXD 2 7 RTS Request to Send
Transmit Data TXD 3 8 CTS Clear to Send
Data Terminal Ready DTR 4 9 RI Ring Indicator
Masse GND 5
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3.2.6 USB und LAN

Aus Platzgriinden werden USB- und LAN-Stecker in Form von Kombi-Bauteilen realisiert, die entweder
zwei USB-Stecker vereinen oder zwei USB-Stecker und einen LAN-Stecker. Auf diese Weise werden bei
allen Boardvarianten vier USB-Kanéle herausgefihrt.

Die USB-Kanéle unterstiitzen die USB-Spezifikation 2.0. Durch das BIOS kdnnen alle notwendigen
Einstellungen fir USB durchgefihrt werden. Es ist zu beachten, dass die Funktionalitat ,USB-Maus und
Tastatur” des BIOS-Setup nur bendtigt wird, wenn das Betriebssystem keine USB-Unterstiitzung bietet.
Fur Einstellungen im Setup und zum Booten von Windows mit einer angeschlossenen USB-Maus und
Tastatur sollte diese Funktion nicht gewahlt werden, weil dies zu erheblichen Leistungseinschrankungen
fuhren wirde.

Die einzelnen USB-Schnittstellen kénnen bis zu 500mA Strom liefern und sind elektronisch abgesichert.
Je nach Boardvariante stehen ein oder zwei Gigabit-LAN-Anschliisse zur Verfligung. An diese kdnnen
neben 10BaseT- und 100BaseT- auch 1000BaseT-kompatible Netzwerkkomponenten angeschlossen
werden. Die erforderliche Geschwindigkeit wird automatisch gewahlt. Auto-Cross und Auto-Negotiate wird
ebenso unterstiitzt wie PXE und RPL. Controller sind 82579L (PHY, LAN1) und 82574L (MAC/PHY, LAN2,
falls vorhanden).

™ = (m ™
o N N
8 1 8 1

P1601 P1602

Pinbelegung USB2.0-Stecker fir Port X:

Pin Name Beschreibung
1 VCC 5V fur USBX
2 USBX# Minus-Datenkanal USBX
3 USBX Plus-Datenkanal USBX
4 GND Masse

Pinbelegung LAN 10/100/1000:

Pin Name Beschreibung
1 LAN2-0 LAN2 Leitung 0 Plus
2 LAN2-0# LAN2 Leitung 0 Minus
3 LAN2-1 LAN2 Leitung 1 Plus
4 LAN2-2 LAN2 Leitung 2 Plus
5 LAN2-2# LAN2 Leitung 2 Minus
6 LAN2-1# LAN2 Leitung 1 Minus
7 LAN2-3 LAN2 Leitung 3 Plus
8 LAN2-3# LAN2 Leitung 3 Minus
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3.2.7 Audio-Anschlisse

Anschlisse fiur Line-In, Line-Out und Mikrofon werden in Form von drei Buchsen fir 3,5mm-Klinkenstecker
herausgefihrt.

Line OUT

Mic

P1502
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3.3 SATA und Memory

3.3.1 SATA-Schnittstellen

Zum Anschluss von SATA-Geraten stehen sechs SATA-Stecker zur Verfigung. Samtliche SATA-Kanale
untertiitzen die Geschwindkeitsmodi 1,5GB/s und 3GB/s. SATAL & SATA2 unterstiitzen dartiber hinaus
auch 6GB/s.

SATA1 SATA3 SATAS

7 psoa 1 7 _psos_1 7 psos 1

[z | e
7 P05 1 7 P507 1 7 P509 1

SATA2 SATA4 SATAG6

Pinbelegung SATA:

Pin Name Beschreibung

1 GND Masse

2 SATATX SATA Senden +

3 SATATX# SATA Senden -

4 GND Masse

5 SATARX# SATA Empfangen -

6 SATARX SATA Empfangen +

7 GND Masse
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3.3.2 Speicher

Auf dem CB1056-Board befinden sich zwei SO-DIMM204-Speichersteckplatze fir
DDR3-1066/1333/1600-RAM. Aus technischen und mechanischen Griinden ist es méglich, dass
bestimmte Speichermodule nicht eingesetzt werden kdnnen. Informieren Sie sich bei lhrem Distributor tiber
die empfohlenen Speichermodule.

Bei zwei Steckplatzen ist mit derzeit erhaltlichen Modulen ein Speicherausbau bis 16 GByte mdglich.

Alle Timingparameter fur die unterschiedlichen Fabrikate und Ausbaustufen werden durch das BIOS
automatisch eingestellt.

SO-DIMM 1

1 ' 71 73

1 71 73
SO-DIMM 2
Beschreibung Name Pin Name Beschreibung
Referenzspannung Memory |REF-DQ 1 2 GND Masse
Masse GND 3 4 DQ4 Datenleitung 4
Datenleitung 0 DQO 5 6 DQ5 Datenleitung 5
Datenleitung 1 DQ1 7 8 GND Masse
Masse GND 9 10 DQSO# Data Strobe O -
Data Mask 0 DMO 11 12 DQSO0 Data Strobe 0 +
Masse GND 13 14 GND Masse
Datenleitung 2 DQ2 15 16 DQ6 Datenleitung 6
Datenleitung 3 DQ3 17 18 DQ7 Datenleitung 7
Masse GND 19 20 GND Masse
Datenleitung 8 DQ8 21 22 DQ12 Datenleitung 12
Datenleitung 9 DQ9 23 24 DQ13 Datenleitung 13
Masse GND 25 26 GND Masse
Data Strobe 1 - DQS1# 27 28 DM1 Data Mask 1
Data Strobe 1 + DQS1 29 30 RESET# Reset
Masse GND 31 32 GND Masse
Datenleitung 10 DQ10 33 34 DQ14 Datenleitung 14
Datenleitung 11 DQ11 35 36 DQ15 Datenleitung 15
Masse GND 37 38 GND Masse
Datenleitung 16 DQ16 39 40 DQ20 Datenleitung 20
Datenleitung 17 DQ17 41 42 DQ21 Datenleitung 21
Masse GND 43 44 GND Masse
Data Strobe 2 - DQS2# 45 46 DM2 Data Mask 2
Data Strobe 2 + DQS2 47 48 GND Masse
Masse GND 49 50 DQ22 Datenleitung 22
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Beschreibung Name Pin Name Beschreibung
Datenleitung 18 DQ18 51 52 DQ23 Datenleitung 23
Datenleitung 19 DQ19 53 54 GND Masse
Masse GND 55 56 DQ28 Datenleitung 28
Datenleitung 24 DQ24 57 58 DQ29 Datenleitung 29
Datenleitung 25 DQ25 59 60 GND Masse
Masse GND 61 62 DQS3# Data Strobe 3 -

Data Mask 3 DQM3 63 64 DQS3 Data Strobe 3 +

Masse GND 65 66 GND Masse

Datenleitung 26 DQ26 67 68 DQ30 Datenleitung 30
Datenleitung 27 DQ27 69 70 DQ31 Datenleitung 31

Masse GND 71 72 GND Masse

Clock Enables 0 CKEO 73 74 CKE1 Clock Enables 1
Versorgungsspannung 1,5V 1,5V 75 76 1,5V Versorgungsspannung 1,5V
Reserviert N/C 77 78 (A15) Reserviert

SDRAM Bank 2 BA2 79 80 Al4 Adressleitung 14
Versorgungsspannung 1,5V 1,5V 81 82 1,5V Versorgungsspannung 1,5V
Adressleitung 12 (Burst A12/BC# 83 84 All Adressleitung 11

Chop)

Adressleitung 9 A9 85 86 A7 Adressleitung 7
Versorgungsspannung 1,5V 1,5V 87 88 1,5V Versorgungsspannung 1,5V
Adressleitung 8 A8 89 90 A6 Adressleitung 6
Adressleitung 5 A5 91 92 A4 Adressleitung 4
Versorgungsspannung 1,5V [1,5V 93 94 1,5V Versorgungsspannung 1,5V
Adressleitung 3 A3 95 96 A2 Adressleitung 2
Adressleitung 1 Al 97 98 A0 Adressleitung 0
Versorgungsspannung 1,5V [1,5V 99 100 1,5V Versorgungsspannung 1,5V
Clock 0 + CKO 101 102 CK1 Clock 1 +

Clock O - CKO# 103 104 CK1# Clock 1 -
Versorgungsspannung 1,5V [1,5V 105 106 1,5V Versorgungsspannung 1,5V
Adressleitung 10 A10/AP 107 108 BAl SDRAM Bank 1
(Autoprecharge)

SDRAM Bank 0 BAO 109 110 RAS# Row Address Strobe
Versorgungsspannung 1,5V [1,5V 111 112 1,5V Versorgungsspannung 1,5V
Write Enable WE# 113 114 SO# Chip Select 0

Column Address Strobe CAS# 115 116 ODTO On Die Termination 0
Versorgungsspannung 1,5V [1,5V 117 118 1,5V Versorgungsspannung 1,5V
Adressleitung 13 Al3 119 120 ODT1 On Die Termination 1

Chip Select 1 S1# 121 122 N/C Reserviert
Versorgungsspannung 1,5V 1,5V 123 124 1,5V Versorgungsspannung 1,5V
Reserviert (TEST) 125 126 REF-CA Referenzspannung

Masse GND 127 128 GND Masse

Datenleitung 32 DQ32 129 130 DQ36 Datenleitung 36
Datenleitung 33 DQ33 131 132 DQ37 Datenleitung 37

Masse GND 133 134 GND Masse

Data Strobe 4 - DQS4# 135 136 DQM4 Data Mask 4

Data Strobe 4 + DQS4 137 138 GND Masse

Masse GND 139 140 DQ38 Datenleitung 38
Datenleitung 34 DQ34 141 142 DQ39 Datenleitung 39
Datenleitung 35 DQ35 143 144 GND Masse

Masse GND 145 146 DQ44 Datenleitung 44
Datenleitung 40 DQ40 147 148 DQ45 Datenleitung 45
Datenleitung 41 DQ41 149 150 GND Masse

Masse GND 151 152 DQS5# Data Strobe 5 -

Data Mask 5 DQM5 153 154 DQS5 Data Strobe 5 +

Masse GND 155 156 GND Masse
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Beschreibung Name Pin Name Beschreibung
Datenleitung 42 DQ42 157 158 DQ46 Datenleitung 46
Datenleitung 43 DQ43 159 160 DQA47 Datenleitung 47
Masse GND 161 162 GND Masse
Datenleitung 48 DQ48 163 164 DQ52 Datenleitung 52
Datenleitung 49 DQ49 165 166 DQ53 Datenleitung 53
Masse GND 167 168 GND Masse
Data Strobe 6 - DQS6# 169 170 DQM6 Data Mask 6
Data Strobe 6 DQS6 171 172 GND Masse
Masse GND 173 174 DQ54 Datenleitung 54
Datenleitung 50 DQ50 175 176 DQ55 Datenleitung 55
Datenleitung 51 DQ51 177 178 GND Masse
Masse GND 179 180 DQ60 Datenleitung 60
Datenleitung 56 DQ56 181 182 DQ61 Datenleitung 61
Datenleitung 57 DQ57 183 184 GND Masse
Masse GND 185 186 DQS7# Data Strobe 7 -
Data Mask 7 DQM7 187 188 DQS7 Data Strobe 7 +
Masse GND 189 190 GND Masse
Datenleitung 58 DQ58 191 192 DQ62 Datenleitung 62
Datenleitung 59 DQ59 193 194 DQ63 Datenleitung 63
Masse GND 195 196 GND Masse
SPD-Adresse 0 SAQ 197 198 EVENT# Event
Versorgungsspannung 3,3V [3,3V 199 200 SDA SMBus Data
SPD-Adresse 1 SAl 201 202 SCL SMBus Clock
Terminierungsspannung VTT 203 204 VTT Terminierungsspannung
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3.4 Anschlisse intern

3.4.1 USB 5-14

Die USB-Kanale 5 bis 14 werden ber flinf 2x5polige Wannenstecker zur Verfiigung gestellt (FCI
75869-301LF, passender Gegenstecker FCI 71600-610LF).

Die USB-Kanale unterstiitzen die USB-Spezifikation 2.0. Durch das BIOS kénnen alle notwendigen
Einstellungen fir USB durchgefihrt werden. Es ist zu beachten, dass die Funktionalitat ,USB-Maus und
Tastatur” des BIOS-Setup nur bendtigt wird, wenn das Betriebssystem keine USB-Unterstiitzung bietet.
Fur Einstellungen im Setup und zum Booten von Windows mit einer angeschlossenen USB-Maus und
Tastatur sollte diese Funktion nicht gewahlt werden, weil dies zu erheblichen Leistungseinschrankungen
fuhren wirde.

Die einzelnen USB-Schnittstellen kdnnen bis zu 500mA Strom liefern und sind elektronisch abgesichert.

1|?2
USB 13/14 >
9f--110
P1506 Ll
11--)2
USB 11/12 -
9f--|10 ;.
P1503 L =
1] -2 %
USB 9/10 :
9{--|10
P1501 R
1 2
USB 7/8
9 10
P1SO7= 2
1|-- |2 ]
USB 5/6 —1
91--110
"

Pinbelegung Wannenstecker USB x/y:

Beschreibung Name Pin Name Beschreibung
5V fiir USBx VCC 1 2 VCC 5V fir USBy
Minus-Datenkanal USBx USBx- 3 4 USBYy- Minus-Datenkanal USBy
Plus-Datenkanal USBx USBx+ 5 6 USBy+ Plus-Datenkanal USBy
Masse GND 7 8 GND Masse
Reserviert N/C 9 10 N/C Reserviert
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3.4.2 Serielle Schnittstellen COM2 bis COM4

Die drei weiteren auf dem Board verfligbaren seriellen Schnittstellen COM2 bis COM4 sind jeweils in Form
eines 2x5poligen Wannensteckers herausgefuhrt (FCI 75869-301LF, passender Gegenstecker FCI

71600-610LF). Die Signale entsprechen der RS232-Norm.

Die Port-Adresse und der benutzte Interrupt werden mit Hilfe des BIOS-Setups eingestellt.

[~} P1603
1|2
COM 2 .
9f-- |10
m—
1|+ ]2
COoM 3 .-
9f-- |10
:P1605
1|2
COM 4 .
9f-- |10

Pinbelegung COM-Stecker:

Beschreibung Name Pin Name Beschreibung
Data Carrier Detect DCD 1 2 DSR Data Set Ready
Receive Data RXD 3 4 RTS Request to Send
Transmit Data TXD 5 6 CTS Clear to Send
Data Terminal Ready DTR 7 8 RI Ring Indicator
Masse GND 9 10 VCC Versorgungsspannung 5V

Beckhoff New Automation Technology CB1056
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3.43 LVDS

Das Board verfiigt tber einen 30poligen Flachsteckeranschluss (JAE FI-X30S-HF-NPB, passender
Gegenstecker: FI-X30C(2)-NPB), an dem LVDS-fahige Displays betrieben werden kdnnen. Es dirfen nur
geschirmte und verdrillte Anschlusskabel benutzt werden. Der verwendete Display-Typ wird Uber das
BIOS-Setup eingetragen. Neben den 30 Anschlusspolen verfugt der Stecker noch tber zwei
Shield-Kontakte S1 und S2, die in der untenstehenden Pin-Tabelle ausgespart worden sind.

LVDS

L T T
P1300

Pinbelegung des 30-poligen LVDS-Steckers:

Pin Name Beschreibung
1 TXO00# LVDS even Data O -
2 TXO00 LVDS even Data 0 +
3 TXO01# LVDS even Data 1 -
4 TXO001 LVDS even Data 1 +
5 TXO02# LVDS even Data 2 -
6 TX002 LVDS even Data 2 +
7 GND Masse
8 TXOO0C# LVDS even Clock -
9 TXO0C LVDS even Clock +
10 |TXOO03# LVDS even Data 3 -
11 |TXO03 LVDS even Data 3 +
12 |TXO10# LVDS odd Data O -
13 |TXO10 LVDS odd Data O +
14 |GND Masse
15 |TXO1l1# LVDS odd Data 1 -
16 |TXO11 LVDS odd Data 1 +
17 |GND Masse
18 |TXO12# LVDS odd Data 2 -
19 |TXO12 LVDS odd Data 2 +
20 |[TXO1C# LVDS odd Clock -
21 |TXO1C LVDS odd Clock +
22 |TXO13# LVDS odd Data 3 -
23 |TXO13 LVDS odd Data 3 +
24 |GND Masse
25 |[3,3V Versorgungsspannung 3,3V
26 |DDC _CLK EDID Clock fir LCD
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Pin Name Beschreibung
27 |DDC_DAT EDID Data fur LCD
28 |FP 3,3V Geschaltete 3,3V fir Display
29 |FP BL Geschaltete 5V fir Backlight
30 |VCC Versorgungsspannung 5V

Beckhoff New Automation Technology CB1056
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3.4.4 CD-In

Neben den externen Klinkenbuchsen gibt es auf dem CB1056-Board noch einen internen 4-poligen
Gehausestecker (Foxconn HF1104E-P1), Gber den weitere analoge Audiosignale verflighar gemacht
werden.

Pinbelegung CD-In-Anschluss:

Pin Name Beschreibung
1 CD L CD linker Kanal
2 CD GND CD-Masse
3 CD GND CD-Masse
4 CD R CD rechter Kanal
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3.4.5 S/PDIF

Fur digitale Audio-Signale steht ein SPDIF-Interface zur Verfligung, das intern an einer 2x3-poligen
Standardstiftleiste fiir Schneidklemmtechnik im Rastermaf? 2,54mm anliegt.

SPDIF X
2

Pinbelegung SPDIF-Anschluss:

Beschreibung Name Pin Name Beschreibung
Masse GND 1 2 SPDIFO SPDIF Out
Versorgungsspannung 3,3V |3,3V 3 4 VCC Versorgungsspannung 5V
Masse GND 5 6 SPDIFI SPDIF In

Beckhoff New Automation Technology CB1056
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3.4.6 PCI-Schnittstellen
Das CB1056-Board verfiigt Gber drei Standard-PCI-Steckplatze fir Erweiterungskarten.

PCI 1

B49
B52

B62

L HINwWEIS

EYRRANERERR RN NN

Bei der folgenden Pinbelegungstabelle ist zu beachten, dass es bei bestimmten Signalen
notwendigerweise Unterschiede zwischen den verschiedenen PCI-Steckern auf dem Board gibt. Dies
betrifft die Testdatensignale (A4, B4), die Interrupt-Signale (A6, A7, B7, B8), das Clock-Signal (B16), das
Grant-Signal (A17), das Request-Signal (B18) und das ID-Select-Signal (A26).

Pinbelegung PCI-Stecker:

Beschreibung Name Pin Name Beschreibung
Test Logic Reset TRST# Al Bl -12V Versorgungsspannung -12V
Versorgungsspannung 12V |12V A2 B2 TCK Test Clock
Test Mde Select TMS A3 B3 GND Masse
Test Data Input TDI A4 B4 TDO Test Data Output
Versorgungsspannung 5V VCC A5 B5 VCC Versorgungsspannung 5V
Interrupt A INTA# A6 B6 VCC Versorgungsspannung 5V
Interrupt C INTC# A7 B7 INTB# Interrupt B
Versorgungsspannung 5V VCC A8 B8 INTD# Interrupt D
Reserviert N/C A9 B9 GND Masse
Versorgungsspannung 5V VCC Al10 B10 N/C Reserviert
Reserviert N/C All B11 GND Masse
Masse GND Al2 B12 GND Masse
Masse GND Al3 B13 GND Masse
Versorgungsspannung 3,3V |3,3VAux Al4 B14 N/C Reserviert
PCI Reset PRST# Al15 B15 |GND Masse
Versorgungsspannung 5V VCC Al6 B16 PCLK Clock
Grant PCl Use GNT# Al7 B17 GND Masse
Masse GND Al8 B18 REQ# Request
Power Management Event  |PME# Al9 B19 VCC Versorgungsspannung 5V
Address/Data 30 AD30 A20 B20 |AD31 Address/Data 31
Versorgungsspannung 3,3V 3,3V A21 B21 AD29 Address/Data 29
Address/Data 28 AD28 A22 B22 GND Masse
Address/Data 26 AD26 A23 B23 |AD27 Address/Data 27
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Beschreibung Name Pin Name Beschreibung
Masse GND A24 B24  |AD25 Address/Data 25
Address/Data 24 AD24 A25 B25 3,3V Versorgungsspannung 3,3V
Init Device Select IDSEL A26 B26 CBE3# Command, Byte Enable 3
Versorgungsspannung 3,3V 3,3V A27 B27 AD23 Address/Data 23
Address/Data 22 AD22 A28 B28 GND Masse
Address/Data 20 AD20 A29 B29 |AD21 Address/Data 21
Masse GND A30 B30 |AD19 Address/Data 19
Address/Data 18 AD18 A3l B31 3,3V Versorgungsspannung 3,3V
Address/Data 16 AD16 A32 B32 |AD17 Address/Data 17
Versorgungsspannung 3,3V [3,3V A33 B33 CBE2# Command, Byte Enable 2
Cycle Frame FRAME# A34 B34 GND Masse
Masse GND A35 B35 IRDY# Initiator Ready
Target Ready TRDY# A36 B36 3,3V Versorgungsspannung 3,3V
Masse GND A37 B37 DEVSEL# Device Select
Stop Request by Target STOP# A38 B38 GND Masse
Versorgungsspannung 3,3V |3,3V A39 B39 PLOCK# Lock Bus
SMBus Clock PCI SMBCLK A40 B40 PERR# Parity Error
SMBus Data PCI SMBDAT A4l B41 3,3V Versorgungsspannung 3,3V
Masse GND A42 B42 SERR# System Error
Parity PAR A43 B43 3,3V Versorgungsspannung 3,3V
Address/Data 15 AD15 Ad4 B44 CBE1# Command, Byte Enable 1
Versorgungsspannung 3,3V |3,3V A45 B45 AD14 Address/Data 14
Address/Data 13 AD13 A46 B46 GND Masse
Address/Data 11 AD11 A47 B47 AD12 Address/Data 12
Masse GND A48 B48 AD10 Address/Data 10
Address/Data 9 AD9 A49 B49 GND Masse
Kodiert N/C A50 B50 N/C Kodiert
Kodiert N/C A51 B51 N/C Kodiert
Command, Byte Enable 0 CBEO# A52 B52 ADS8 Address/Data 8
Versorgungsspannung 3,3V |3,3V A53 B53 AD7 Address/Data 7
Address/Data 6 AD6 A54 B54 3,3V Versorgungsspannung 3,3V
Address/Data 4 AD4 AbB5 B55 AD5 Address/Data 5
Masse GND A56 B56 |AD3 Address/Data 3
Address/Data 2 AD2 A57 B57 GND Masse
Address/Data 0 ADO A58 B58 |AD1 Address/Data 1
Versorgungsspannung 5V VCC A59 B59 VCC Versorgungsspannung 5V
Reserviert N/C A60 B60 |VCC Versorgungsspannung 5V
Versorgungsspannung 5V VCC A61 B61 VCC Versorgungsspannung 5V
Versorgungsspannung 5V VCC AB2 B62 VCC Versorgungsspannung 5V

Beckhoff New Automation Technology CB1056
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3.4.7 PCIl-Express Schnittstellen (x1)

Auf dem CB1056-Board stehen zwei Steckplatze fur PCI-Express-x1-Erweiterungskarten zur Verfligung.

L HINwWEIS

Wenn der PCI-Express-x4-Steckplatz (Seite 43) durch ein x4-Device belegt ist, dann ist der
PCI-Express-x1-Steckplatz 2 abgeschaltet.

PCle-x1 2

PCle-x1 1

L HINWEIS

Bei der folgenden Pinbelegungstabelle ist zu beachten, dass es bei bestimmten Signalen
notwendigerweise Unterschiede zwischen den verschiedenen PCle-x1-Steckern auf dem Board gibt. Dies
betrifft die Clock-Signale (A13, A14), die Receive-Signale (A16, A17) und die Transmit-Signale (B14, B15).

Pinbelegung PCI-Express-x1-Stecker:

Beschreibung Name Pin Name Beschreibung
Hot Plug Detect 1 PRSNT1# |Al Bl 12v Versorgungsspannung 12V
Versorgungsspannung 12V |12V A2 B2 12v Versorgungsspannung 12V
Versorgungsspannung 12V |12V A3 B3 N/C Reserviert
Masse GND A4 B4 GND Masse
Reserviert N/C A5 B5 SMBCLK SMBus Clock PCle
Reserviert N/C A6 B6 SMBDAT SMBus Data PCle
Reserviert N/C A7 B7 GND Masse
Reserviert N/C A8 B8 3,3V Versorgungsspannung 3,3V
Versorgungsspannung 3,3V |3,3V A9 B9 N/C Reserviert
Versorgungsspannung 3,3V |3,3V Al0 B10 S3,3V Standby-Spannung 3,3V
PCle Reset PERST# All B11 PEWAKE# |Link Reactivation
Masse GND Al12 B12 N/C Reserviert
Reference Clock + REFCLK Al13 B13 GND Masse
Reference Clock - REFCLK# [Al14 B14 PETO Transmit Lane 0 +
Masse GND Al15 B15 PETO# Transmit Lane O -
Receive Lane 0 + PERO Al6 B16 GND Masse
Receive Lane 0 - PERO# Al7 B17 PRSNT2# |Hot Plug Detect 2
Masse GND Al18 B18 GND Masse
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3.4.8 PCI-Express Schnittstelle (x4)

Auf dem CB1056-Board steht ein Steckplatz fiir PCI-Express-x4-Erweiterungskarten zur Verfiigung. In
diesem kann auch eine x1-Erweiterungskarte betrieben werden.

L HINWEIS

Wenn der Steckplatz durch ein x4-Device belegt ist, dann ist der PCI-Express-x1-Steckplatz 2 (s. p. 42)

abgeschaltet.

B1

PCle-x4

B32

Pinbelegung PCI-Express-x4-Stecker:

]
Pt

Beschreibung Name Pin Name Beschreibung
Hot Plug Detect 1 PRSNT1# |Al Bl 12v Versorgungsspannung 12V
Versorgungsspannung 12V |12V A2 B2 12v Versorgungsspannung 12V
Versorgungsspannung 12V |12V A3 B3 N/C Reserviert
Masse GND A4 B4 GND Masse
Reserviert N/C A5 B5 SMBCLK SMBus Clock PCle
Reserviert N/C A6 B6 SMBDAT SMBus Data PCle
Reserviert N/C A7 B7 GND Masse
Reserviert N/C A8 B8 3,3V Versorgungsspannung 3,3V
Versorgungsspannung 3,3V 3,3V A9 B9 N/C Reserviert
Versorgungsspannung 3,3V |3,3V A10 B10 S3,3V Standby-Spannung 3,3V
PCle Reset PERST# All B11 PEWAKE# |Link Reactivation
Masse GND Al2 B12 N/C Reserviert
Reference Clock + REFCLK Al3 B13 GND Masse
Reference Clock - REFCLK# Al4 B14 PETO Transmit Lane 0 +
Masse GND Al5 B15 PETO# Transmit Lane O -
Receive Lane 0 + PERO Al6 B16 GND Masse
Receive Lane 0 - PERO# Al7 B17 PRSNT2# Hot Plug Detect 2
Masse GND Al18 B18 GND Masse
Reserviert N/C Al19 B19 PET1 Transmit Lane 1 +
Masse GND A20 B20 PET1# Transmit Lane 1 -
Receive Lane 1 + PER1 A21 B21 GND Masse
Receive Lane 1 - PER1# A22 B22 GND Masse
Masse GND A23 B23 PET2 Transmit Lane 2 +
Masse GND A24 B24 PET2# Transmit Lane 2 -
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Beschreibung Name Pin Name Beschreibung
Receive Lane 2 + PER2 A25 B25 GND Masse
Receive Lane 2 - PER2# A26 B26 GND Masse
Masse GND A27 B27 PET3 Transmit Lane 3 +
Masse GND A28 B28 PET3# Transmit Lane 3 -
Receive Lane 3 + PER3 A29 B29 GND Masse
Receive Lane 3 - PER3# A30 B30 N/C Reserviert
Masse GND A3l B31 PRSNT2# Hot Plug Detect 2
Reserviert N/C A32 B32 GND Masse
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3.4.9 PCI-Express Schnittstellen (x16)

Ein Steckplatz fir PCI-Express-x16-Karten rundet das Angebot der verfiigbaren
Erweiterungsmaglichkeiten auf dem CB1056-Board ab. Dieser Steckplatz kann fir PCle-x16-Grafikkarten
genutzt werden. Es kann auch eine x1- oder x4-Erweiterungskarte in diesem Steckplatz betrieben werden.

PCle-x16

B82

P1301

A82

Pinbelegung PCI-Express-x16-Stecker:

Beschreibung Name Pin Name Beschreibung
Hot Plug Detect 1 PRSNT1# |Al Bl 12v Versorgungsspannung 12V
Versorgungsspannung 12V  [12V A2 B2 12V Versorgungsspannung 12V
Versorgungsspannung 12V |12V A3 B3 N/C Reserviert
Masse GND A4 B4 GND Masse
Reserviert N/C A5 B5 SMBCLK SMBus Clock PCle
Reserviert N/C A6 B6 SMBDAT SMBus Data PCle
Reserviert N/C A7 B7 GND Masse
Reserviert N/C A8 B8 3,3V Versorgungsspannung 3,3V
Versorgungsspannung 3,3V |3,3V A9 B9 N/C Reserviert
Versorgungsspannung 3,3V |3,3V Al10 B10 S3,3V Standby-Spannung 3,3V
PCle Reset PERST# All B11 PEWAKE# |Link Reactivation
Masse GND Al2 B12 N/C Reserviert
Reference Clock + REFCLK Al3 B13 GND Masse
Reference Clock - REFCLK# Al4d B14 PETO Transmit Lane 0 +
Masse GND Al15 B15 PETO# Transmit Lane O -
Receive Lane 0 + PERO Al6 B16 GND Masse
Receive Lane 0 - PERO# Al7 B17 PRSNT2# Hot Plug Detect 2
Masse GND Al8 B18 GND Masse
Reserviert N/C Al9 B19 PET1 Transmit Lane 1 +
Masse GND A20 B20 PET1# Transmit Lane 1 -
Receive Lane 1 + PER1 A21 B21 GND Masse
Receive Lane 1 - PER1# A22 B22 GND Masse
Masse GND A23 B23 PET2 Transmit Lane 2 +
Masse GND A24 B24 PET2# Transmit Lane 2 -
Receive Lane 2 + PER2 A25 B25 GND Masse
Receive Lane 2 - PER2# A26 B26 GND Masse
Masse GND A27 B27 PET3 Transmit Lane 3 +
Masse GND A28 B28 PET3# Transmit Lane 3 -
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Beschreibung Name Pin Name Beschreibung
Receive Lane 3 + PER3 A29 B29 GND Masse
Receive Lane 3 - PER3# A30 B30 N/C Reserviert
Masse GND A31l B31 PRSNT2# Hot Plug Detect 2
Reserviert N/C A32 B32 GND Masse
Reserviert N/C A33 B33 PET4 Transmit Lane 4 +
Masse GND A34 B34 PETA4# Transmit Lane 4 -
Receive Lane 4 + PER4 A35 B35 GND Masse
Receive Lane 4 - PER4# A36 B36 GND Masse
Masse GND A37 B37 PET5 Transmit Lane 5 +
Masse GND A38 B38 PETS5# Transmit Lane 5 -
Receive Lane 5 + PER5 A39 B39 GND Masse
Receive Lane 5 - PER5S# A40 B40 GND Masse
Masse GND A4l B41 PET6 Transmit Lane 6 +
Masse GND A42 B42 PET6# Transmit Lane 6 -
Receive Lane 6 + PERG6 A43 B43 GND Masse
Receive Lane 6 - PERG6# Ad4 B44 GND Masse
Masse GND A45 B45 PET7 Transmit Lane 7 +
Masse GND A46 B46 PET7# Transmit Lane 7 -
Receive Lane 7 + PER7 A47 B47 GND Masse
Receive Lane 7 - PER7# A48 B48 PRSNT2# Hot Plug Detect 2
Masse GND A49 B49 GND Masse
Reserviert N/C A50 B50 PETS8 Transmit Lane 8 +
Masse GND A51 B51 PET8# Transmit Lane 8 -
Receive Lane 8 + PERS8 A52 B52 GND Masse
Receive Lane 8 - PER8# A53 B53 GND Masse
Masse GND A54 B54 PET9 Transmit Lane 9 +
Masse GND A55 B55 PET9# Transmit Lane 9 -
Receive Lane 9 + PER9 A56 B56 GND Masse
Receive Lane 9 - PER9# A57 B57 GND Masse
Masse GND A58 B58 PET10 Transmit Lane 10 +
Masse GND A59 B59 PET10# Transmit Lane 10 -
Receive Lane 10 + PER10 A60 B60 GND Masse
Receive Lane 10 - PER10# A61 B61 GND Masse
Masse GND A62 B62 PET11 Transmit Lane 11 +
Masse GND A6B3 B63 PET11# Transmit Lane 11 -
Receive Lane 11 + PER11 A64 B64 GND Masse
Receive Lane 11 - PER11# AB5 B65 GND Masse
Masse GND A66 B66 PET12 Transmit Lane 12 +
Masse GND A67 B67 PET12# Transmit Lane 12 -
Receive Lane 12 + PER12 A68 B68 GND Masse
Receive Lane 12 - PER12# A69 B69 GND Masse
Masse GND A70 B70 PET13 Transmit Lane 13 +
Masse GND A71 B71 PET13# Transmit Lane 13 -
Receive Lane 13+ PER13 A72 B72 GND Masse
Receive Lane 13- PER13# A73 B73 GND Masse
Masse GND A74 B74 PET14 Transmit Lane 14 +
Masse GND A75 B75 PET14# Transmit Lane 14 -
Receive Lane 14 + PER14 A76 B76 GND Masse
Receive Lane 14 - PER14# AT7 B77 GND Masse
Masse GND A78 B78 PET15 Transmit Lane 15 +
Masse GND A79 B79 PET15# Transmit Lane 15 -
Receive Lane 15 + PER15 A80 B80 GND Masse
Receive Lane 15 - PER15# A81 B81 N/C Reserviert
Masse GND AB82 B82 N/C Reserviert
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3.4.10 SMB/I2C

Die Baugruppe besitzt die Fahigkeit, mit anderen Schaltelementen liber das SMBus- oder das
I2C-Protokoll zu kommunizieren. Die Anschlisse hierfiir sind in einem 2x5poligen Wannenstecker realisiert
(JST B10B-PHDSSLFSN, passender Gegenstecker: PHDR-10VS). Die SMBus-Signale werden durch den
Chipsatz verarbeitet, die 12C-Signale durch den SIO-Chip.

P1504

SMB/I2C =
10L-415

Pinbelegung SMB/I2C-Stecker:

Beschreibung Name Pin Name Beschreibung
Versorgungsspannung 3,3V |3,3V 1 6 GND Masse
SMBus Clock SMBCLK 2 7 SMBDAT SMBus Data
SMBus Alarm SMBALRT# |3 8 SVCC Standby-Versorgung 5V
12C-Bus Clock 12CLK 4 9 12DAT 12C-Bus Data
Versorgungsspannung 5V VCC 5 10 GND Masse
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3.4.11 GPIO

Das Board verfiigt Gber eine General Purpose Input/Output-Schnittstelle, die tber einen 2x10poligen
Wannenstecker herausgefihrt ist (JST B20B-PHDSSLFSN, passender Gegenstecker: PHDR-20VS).
Durch entsprechende Programmierung des zugehorigen Chips (Super-10) kénnen hier in sehr flexibler
Weise I/0-Funktionen angelegt werden. Erkundigen Sie sich bei Ihrem Distributor nach entsprechender
Software-Unterstitzung.

GPIO

Pinbelegung GPIO-Stecker:

Beschreibung Name Pin Name Beschreibung
Versorgungsspannung 5V VCC 1 11 VCC Versorgungsspannung 5V
GP Input/Output 10 GPIO10 2 12 N/C Reserviert
GP Input/Output 11 GPIO11 3 13 N/C Reserviert
GP Input/Output 12 GPI012 4 14 N/C Reserviert
GP Input/Output 13 GPIO13 5 15 N/C Reserviert
GP Input/Output 14 GPIO14 6 16 N/C Reserviert
GP Input/Output 15 GPIO15 7 17 N/C Reserviert
GP Input/Output 16 GPIO16 8 18 N/C Reserviert
GP Input/Output 17 GPIO17 9 19 N/C Reserviert
Masse GND 10 20 GND Masse
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3.4.12 Liufteranschlisse

Die Baugruppe verfligt Uber vier 3polige Lifteranschliisse. Diese ermdglichen es, Lifter mit einer
Versorgungsspannung von 12 Volt direkt an die Baugruppe anzuschlie3en. Die Anschliisse FAN1, FAN2
und FANS3 verfligen tber eine Drehzahliberwachungsfunktion. Wenn diese genutzt werden soll, muss der
angeschlossene Liifter ein entsprechendes Tachometer-Signal liefern.

FAN 2 .

FAN 1

P502

FAN3 . . .
3 1

P503

3 -
AN 4 I\
1.

Pinbelegung Lifterstecker:

Pin Name Beschreibung
1 GND Masse
2 12v Versorgungsspannung 12V geregelt
3 TACHO Uberwachungssignal Liifter
L HINWEIS

Bei FAN4 ist Pin 3 nicht verbunden (N/C).
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3.5 Jumper-Einstellungen

3.5.1 Clear CMOS

Wenn das Board nicht mehr bootet oder das BIOS-Setup nicht mehr aufgerufen werden kann, dann kénnen
mit den "Clear CMOS"-Jumpern die im CMOS gespeicherten Einstellungen zuriickgesetzt werden. Zu
diesem Zweck muss der Rechner ausgeschaltet werden und zunachst Jumper 1 und dann Jumper 2 von
ihrer Normalposition (Kontakte 1 & 2 geschlossen) abgenommen und in die Position "Kontakte 2 & 3
geschlossen" gesteckt werden. Nach ein paar Sekunden werden die Jumper wieder in die Normalposition
zuruickgesteckt. Anschliel3end bootet das Board in der ab Werk gelieferten Default-Einstellung.

A ACHTUNG

Um zu verhindern, dass das System in einen undefinierten Zustand gerat, ist unbedingt darauf zu achten,
dass das Kurzschliessen des Jumper Clear CMOS 1 (J1800) unbedingt VOR und nur zusammen mit dem
Setzen des Jumper Clear CMOS 2 (J1801) erfolgen darf.

Bitte beachten Sie weiterhin, dass ein Zurlicksetzen des CMOS alle im BIOS-Setup vorgenommenen
Einstellungen und damit auch die dort gespeicherte Uhrzeit I6scht, so dass die Uhr anschlieRend wieder
gestellt werden muss.

Jumper:

Clear CMOS 1

Clear CMOS 2
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3.5.2 Jumper: Keyboard Power (KBPWR)

Tastatur und Maus kénnen entweder Uber die normale Versorgungsspannung VCC oder Uber die
Standby-Spannung SVCC versorgt werden. Welche Spannung gewahlt wird, hangt von der Einstellung des
KBPWR-Jumpers ab. Sind die Kontakte 1 und 2 geschlossen, dann liegt VCC an, sind 2 und 3
geschlossen, dann SVCC.
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4 BIOS-Einstellungen

4.1 Benutzung des Setups

Innerhalb der einzelnen Setup-Seiten kdnnen jederzeit mit F2 (,Previous Values®) die zuletzt
abgespeicherten Einstellungen wieder hergestellt werden. Mit F3 (,Optimized Defaults“) werden werkseitig
festgelegte Standardwerte geladen. F2/F3 und auch F4 ("Save & Exit") laden bzw. sichern immer den
kompletten Satz an Einstellungen.

Ein ,»“-Zeichen vor dem Menlpunkt bedeutet, dass ein Untermenti vorhanden ist. Die Navigation von
einem Menupunkt zum anderen erfolgt mit Hilfe der Pfeiltasten, wobei mit der Enter-Taste der
entsprechende Menipunkt ausgewdhlt wird, was dann z. B. den Aufruf eines Unterments oder eines
Auswabhldialogs bewirkt.

Zu jeder einzelnen Setup-Option wird oben rechts ein Hilfetext angezeigt, der in vielen Fallen nitzliche
Informationen zur Bedeutung der Option, zu erlaubten Werten usw., enhalt.

L HINWEIS

Das BIOS wird regelmé&Rig weiterentwickelt, so dass die verfliigbaren Setup-Optionen sich jederzeit und
ohne gesonderte Mitteilung andern kdnnen. Dadurch kann es zu Abweichungen kommen zwischen den
tatsachlich vorhandenen Optionen und denen, die nachfolgend beschrieben werden. Zu beachten ist
aulBerdem, dass die in den Setup-MenUs im Folgenden gezeigten Einstellungen nicht notwendigerweise
die empfohlenen oder die Default-Einstellungen sind. Welche Einstellungen gewéhlt werden mussen,
hangt jeweils vom Anwendungsszenario ab, in dem das Board betrieben wird.
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(C) 2012 American Megatrends, Inc.

MAIN Advanced Chipset Boot Security Save & Exit
Set the Date. Use Tab to
Board Information switch between Data elements.
Board CB1056
Revision 3
Bios Version 1.37
Processor Information
Name SandyBridge
Brand String Intel (R) Celeron(R) CPU
Frequency 1400 MHz
Processor ID 206a7
Stepping D2
Number of Processors 1Core(s) / 1Thread(s)
Microcode Revision 28 ——: Select Screen
GT Info GT1 (800 MHz) t1: Select Item
Enter: Select
IGFX VBIOS Version 2165 +/-: Change Opt.
Memory RC Version 1.2.2.0 Fl: General Help

Total Memory
Memory Frequency

System Date
System Time

4096 MB (DDR3)
1333 Mhz

[Mon 27/02/2014]
[00:47:04]

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright

v' Board
Optionen: keine

v' Revision
Optionen: keine

v' Bios Version
Optionen: keine

v" Processor Information
Optionen: keine

v" Name
Optionen: keine

v' Brand String

Optionen: keine
v' Frequency
Optionen: keine
v" Processor ID
Optionen: keine
v' Stepping
Optionen: keine

v" Number of Processors
Optionen: keine

v' Microcode Revision
Optionen: keine

(C) 2012 American Megatrends,

Beckhoff New Automation Technology CB1056

Inc.
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v

GT Info
Optionen: keine

IGFX VBIOS Version
Optionen: keine

Memory RC Version
Optionen: keine

Total Memory
Optionen: keine

Memory Frequency
Optionen: keine

System Date

Main

Optionen: Hier kann das Systemdatum geéandert werden.

System Time

Optionen: Hier kann die Systemzeit geandert werden.

Seite 54
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4.3 Advanced

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Main ADVANCED Chipset Boot Security Save & Exit

Kapitel: BIOS-Einstellungen

VYVVYVVVYYYVYYVYY

Power-Supply Type
SoftOff on Overheat

PCI Subsystem Settings

ACPI Settingstion
CPU Configuration
SATA Configuration

Power Controller Options

USB Configuration

Super IO Configuration

H/W Monitor

Serial Port Console Redirection

Network Stack

CPU PPM Configuration

Intel (R) 82579LM Gigabit Network Connection - 00:01:05:1...

[ATX] Select the Type of the Power
[Disabled] Supply: AT/ATX

i

Intel (R) 82574L Gigabit Network Connection - 00:01:05:11... +/-:

ESC:

: Select Screen
Enter: Select

: General Help

: Previous Values

: Optimized Defaults
: Save & Exit

Select Item

Change Opt.

Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

Power-Supply Type
Optionen: ATX /AT

SoftOff on Overheat
Optionen: Disabled / Enabled

PCI Subsystem Settings

Untermendi: siehe

ACPI Settings
Untermendi: siehe

"PCI Subsystem Settings" (Seite 57)

"ACPI Settings" (Seite 59)

CPU Configuration

Untermendi: siehe

"CPU Configuration” (Seite 60)

SATA Configuration

Untermeni: siehe

"SATA Configuration" (Seite 62)

Power Controller Options

Untermend: siehe

"Power Controller Options" (Seite 63)

USB Configuration

Untermendii: siehe

"USB Configuration" (Seite 65)

Super 10 Configuration

Untermeni: siehe

H/W Monitor
Untermeni: siehe

"Super 10 Configuration" (Seite 66)

"H/W Monitor" (Seite 68)

Serial Port Console Redirection

Untermend: siehe

"Serial Port Console Redirection" (Seite 70)

Beckhoff New Automation Technology CB1056
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v" Network Stack
Untermenu: siehe "Network Stack” (Seite 72)

v" CPU PPM Configuration
Untermenu: siehe "CPU PPM Configuration” (Seite 73)

v Intel(R) Gigabit Network Connection
Untermenu: siehe "Intel(R) GigabitNetworkConnection" (Seite 74)
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4.3.1 PCIl Subsystem Settings

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced
PCI Bus Driver Version vV 2.05.02 Enables or Disables 64bit
capable Devices to be Decoded
in Above 4G Address Space
PCI 64bit Resources Handling (Only if System Supports 64
Above 4G Decoding [Disabled] bit PCI Decoding) .

PCI Common Settings
PCI Latency Timer [32 PCI Bus Clocks]

» PCI Express Settings

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v Above 4G Decoding
Optionen: Enabled / Disabled

v' PCI Latency Timer
Optionen: 32, 64,...224, 248 PCI Bus Clocks

v PCI Express Settings
Unterment: siehe "PCI Express Settings" (Seite 58)

Beckhoff New Automation Technology CB1056 Seite 57
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4.3.1.1 PCIl Express Settings

Aptio Setup Utility - Copyright
Advanced

Advanced

(C) 2012 American Megatrends, Inc.

PCI Express Device Register Settings

WARNING: Enabling ASPM may cause some
PCI-E devices to fail

Relaxed Ordering [Disabled]
Extended Tag [Disabled]
No Snoop [Enabled]
Maximum Payload [Auto]
Maximum Read Request [Auto]

PCI Express Link Register Settings

ASPM Support [Disabled]

Extended Synch [Disabled]
Link Training Retry [5]

Link Training Timeout (uS) 100
Unpopulated Links [Disable]

Enables or Disables PCI
Express Device Relaxed
Ordering

Select Screen
Select Item

-l

R

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

v" Relaxed Ordering
Optionen: Enabled / Disabled

v' Extended Tag

Optionen: Enabled / Disabled
v No Snoop
Optionen: Enabled / Disabled

v" Maximum Payload
Optionen:

v" Maximum Read Request
Optionen:

v' ASPM Support
Optionen: Disabled / Auto / Force LOs

v' Extended Synch
Optionen: Enabled / Disabled

v" Link Training Retry
Optionen: Disabled/2/3/5

v' Link Training Timeout (uS)
Optionen: 10...1000

v" Unpopulated Links
Optionen: Keep Link ON / Disable Link

Seite 58

Copyright (C)

2012 American Megatrends, Inc.

Auto / 128 Bytes / 256 Bytes / 512 Bytes / 1024 Bytes / 2048 Bytes / 4096 Bytes

Auto / 128 Bytes / 256 Bytes / 512 Bytes / 1024 Bytes / 2048 Bytes / 4096 Bytes
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4.3.2 ACPI Settings

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced
ACPI Settings Enables or Disables BIOS ACPI
Auto Configuration.
Enable ACPI Auto Configuration [Disabled]
Enable Hibernation [Enabled]
ACPI Sleep State [S1 only(CPU Stop Cl...]
Lock Legacy Resources [Disabled]

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v' Enable ACPI Auto Configuration
Optionen: Enabled / Disabled

v" Enable Hibernation
Optionen: Enabled / Disabled

v ACPI Sleep State
Optionen: Suspend Disabled / S1 (CPU Stop Clock)

v" Lock Legacy Resources
Optionen: Enabled / Disabled

Beckhoff New Automation Technology CB1056 Seite 59
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4.3.3 CPU Configuration

Aptio Setup Utility - Copyright (C)

Advanced

2012 American Megatrends, Inc.

CPU Configuration

CPU Signature
Microcode Patch

Max CPU Speed

Min CPU Speed

CPU Speed

Processor Cores

Intel HT Technology
Intel VT-x Technology
Intel SMX Technology
64-bit

L1 Data Cache
L1 Code Cache
L2 Cache
L3 Cache

Hyperthreading

Active Processor Cores
Limit CPUID Maximum
Execute Disable Bit

TCC Activation offset
Primary Plane Current value
Secondary Plane Current value

Intel Virtualization Technology

Intel (R) Celeron(R) CPU 827E @ 1.4GHz

206a7

28

1400 MHz

800 MHz

1400 MHz

1

Not Supported
Supported

Not Supported
Supported

32 kB x 1
32 kB x 1
256 kB x 1
1536 kB

[Enabled]
[Al1l]
[Disabled]
[Enabled]
[Disabled]
0
0
0

Disabled for Windows XP

——: Select Screen

tl: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

v' CPU Signature
Optionen: keine

v Microcode Patch
Optionen: keine

v Max CPU Speed
Optionen: keine

v Min CPU Speed
Optionen: keine

v' CPU Speed
Optionen: keine

v" Processor Cores
Optionen: keine

v' Intel HT Technology
Optionen: keine

v" Intel VT-x Technology
Optionen: keine

v" Intel SMX Technology
Optionen: keine

v’ 64-bit
Optionen: keine

v' L1 Data Cache
Optionen: keine

Seite 60
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Beckhoff New Automation Technology CB1056

L1 Code Cache
Optionen: keine

L2 Cache
Optionen: keine

L3 Cache
Optionen: keine

Hyper-threading
Optionen: Disabled / Enabled

Active Processor Cores
Optionen: All

Limit CPUID Maximum
Optionen: Enabled / Disabled

Execute Disable Bit
Optionen: Enabled / Disabled

Intel Virtualization Technology
Optionen: Enabled / Disabled

TCC Activation Offset
Optionen: 0...15

Primary Plane Current value
Optionen: 0...255

Secondary Plane Current value
Optionen: 0...255

Kapitel: BIOS-Einstellungen
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4.3.4 SATA Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends,

Advanced

Inc.

SATA Controller(s)
SATA Mode Selection
SATA Test Mode
Alternate ID

Serial ATA Port 0
Software Preserve
Port O
Hot Plug
Spin Up Device

Serial ATA Port 1
Software Preserve
Port 1
Hot Plug
Spin Up Device

Serial ATA Port 2
Software Preserve
Port 2
Hot Plug
External SATA
Hot Plug
Spin Up Device

Serial ATA Port 3
Software Preserve
Port 3
Hot Plug
External SATA

[Enabled]
[RAID]
[Disabled]
[Disabled]
Empty
Unknown
[Enabled]
[Enabled]
[Disabled]
Empty
Unknown
[Enabled]
[Enabled]
[Disabled]
Empty
Unknown
[Enabled]
[Disabled]
[Disabled]
[Enabled]
[Disabled]
Empty
Unknown
[Enabled]
[Enabled]
[Disabled]

Enable or disable SATA Device.

F4:
ESC:

A
tes
Enter:
+/-:
Fl:
F2:
F3:

Drive]
v

Select Screen
Select Item n
Select

Change Opt.
General Help
Previous Values
Optimized Defaults
Save & Exit

Exit

Version 2.15.1236.

SATA Controller(s)
Optionen: Enabled / Disabled

SATA Mode Selection
Optionen: IDE/ AHCI/RAID

SATA Test Mode

Optionen: Enabled / Disabled
Alternate ID

Optionen: Enabled / Disabled
Serial ATA Port X

Optionen: keine

Software Preserve

Optionen: keine

Port X

Optionen: Enabled / Disabled
Hot Plug

Optionen: Enabled / Disabled

External SATA
Optionen: Enabled / Disabled

Spin Up Device
Optionen: Enabled / Disabled

Seite 62

Copyright (C)

2012 American Megatrends, Inc.

Advanced

Beckhoff New Automation Technology CB1056



Advanced

4.3.5 Power Controller Options

Kapitel: BIOS-Einstellungen

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced

Bootloader Version
Firmware Version
Mainboard Serial No

Mainboard Prod. Date (Week.Year)

Mainboard BootCount
Mainboard Operation Time
Voltage (Min/Max)
Temperature (Min/Max)

ext. USB-Port Voltage
int. USB-Port Voltage

WatchDogTimer Mode
WDT OSBOOT Timeout

1.00-07

1.00-35
0948251130007
28.12

128

12090min (201h)
4.60V / 5.20V
18'C /51'C

[Off in S3-5]
[Off in S3-5]

[Normal Mode]
[Disabled]

Select Power line for external
USB devices, 1f powered-down

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

Bootloader Version
Optionen: keine

Firmware Version
Optionen: keine

Mainboard Serial No
Optionen: keine

Copyright (C) 2012 American Megatrends, Inc.

Mainboard Prod. Date (Week.Year)

Optionen: keine

Boot Count
Optionen: keine

Minute Meter
Optionen: keine

Voltage (Min/Max)
Optionen: keine

Temperature (Min/Max)
Optionen:  keine

ext. USB-Port Voltage

Optionen:  Off in S3-5/ by SVCC

int. USB-Port Voltage

Optionen:  Off in S3-5/ by SVCC

WatchDogTimer Mode

Optionen: Normal Mode / Compatibility Mode

Beckhoff New Automation Technology CB1056
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v WDT OSBoot Timeout
Optionen: Disabled / 45 Seconds ... 255 Seconds

Seite 64 Beckhoff New Automation Technology CB1056
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4.3.6 USB Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced
USB Configuration Enables Legacy USB support.
AUTO option disables legacy
USB Devices: support if no USB devices are
1 Drive, 1 Keyboard, 1 Mouse connected. DISABLE option will
keep USB devices available
Legacy USB Support [Auto] only for EFI applications.
USB3.0 Support [Enabled]
XHCI Hand-off [Enabled]
EHCI Hand-off [Enabled]
USB hardware delays and time-outs:
USB transfer time-out 5 sec]
Device reset time-out 10 sec]

[
[
Device power-up delay [Manual] ——: Select Screen
Device power-up delay in seconds 5 t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v USB Devices
Optionen: keine

v' Legacy USB Support
Optionen: Enabled / Disabled / Auto

v USB3.0 Support
Optionen: Enabled / Disabled

v" XHCI Hand-off
Optionen: Enabled / Disabled

v' EHCI Hand-off
Optionen: Enabled / Disabled

v' USB transfer time-out
Optionen: 5 sec/ 10 sec/ 20 sec

v" Device reset time-out
Optionen: 10 sec/ 20 sec /30 sec /40 sec

v' Device power-up delay
Optionen:  Auto / Manual

v" Device power-up delay in seconds
Optionen: 1..40

Beckhoff New Automation Technology CB1056 Seite 65
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4.3.7 Super 10 Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced
Super IO Configuration Set Parameters of Serial Port
0 (CoMR)
Super IO Chip SMSC SCH3114

» Serial Port 0 Configuration
» Serial Port 1 Configuration

—<: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v" Super IO Chip
Optionen: keine

v Serial Port X Configuration
Untermenu: siehe "Serial Port Configuration" (Seite 67)
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4.3.7.1 Serial Port Configuration

Kapitel: BIOS-Einstellungen

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced

Serial Port 0 Configuration

Serial Port [Enabled]
Device Settings IO=3F8h; IRQ=4;
Change Settings [Auto]

Device Mode [Normal]

Enable or Disable Serial Port
(COM)

——: Select Screen

t11: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v Serial Port
Optionen: Enabled / Disabled

v' Device Settings
Optionen: keine

v Change Settings
Optionen:  Auto/10=3F8h; IRQ=4/10=3F8h; IRQ=3,
...12 /10=2E8h; IRQ=3, ...12

v" Device Mode
Optionen: Normal / High Speed

Beckhoff New Automation Technology CB1056
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4.3.8 H/W Monitor

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced

H/W Monitor

CPU Temperature
Board Temperature
Memory Temperature
SYS FAN Speed

CPU FAN Speed
AUX FAN Speed
+1.05V

VccCore

+3.3V

Vcce

+12V

VTR

Vbat

ol

R

Select Screen
Select Item

Enter: Select

+/=:
Fl:
F2:
F3:
F4:
ESC:

Change Opt.
General Help
Previous Values
Optimized Defaults
Save & Exit

Exit

Version 2.15.1236.

v CPU Temperature
Optionen: keine

v Board Temperature
Optionen: keine

v Memory Temperature

Optionen: keine

v SYS FAN Speed
Optionen: keine

v CPU FAN Speed
Optionen: keine

v AUX FAN Speed
Optionen:  keine

v’ +1.05V
Optionen: keine

v" VccCore
Optionen:  keine

v +3.3V
Optionen: keine

v Vcc
Optionen: keine

v +12V
Optionen: keine

Seite 68
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v VTR
Optionen: keine

v' Vbat
Optionen: keine

Beckhoff New Automation Technology CB1056 Seite 69
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4.3.9 Serial Port Console Redirection

Aptio
Advanced

Setup Utility - Copyright

(C)

2012 American Megatrends, Inc.

COMO
Console
» Console

COM1
Console
» Console

COM2
Console
» Console

CoM3
Console
» Console

Redirection
Redirection

Redirection
Redirection

Redirection
Redirection

Redirection
Redirection

Settings

Settings

Settings

Settings

[Enabled]

[Disabled]

[Disabled]

[Disabled]

Console Redirection Enable or
Disable.

R

Fl:
F2:
F3:
F4:
ESC:

: Select Screen

Select Item

Enter: Select
+/-:

Change Opt.
General Help
Previous Values
Optimized Defaults
Save & Exit

Exit

Version 2.15.1236.

v Console Redirection

Optionen:

v' Console Redirection Settings
Untermenu: siehe

Seite 70
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4.3.9.1 Console Redirection Settings

Kapitel: BIOS-Einstellungen

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Advanced

COMO Emulation: ANSI: Extended

Console Redirection Settings ASCII char set. VT100: ASCII
char set. VT100+: Extends

Terminal Type [VI-UTF8] VT100 to support color,

Bits per second [115200] function keys, etc. VT-UTFS8:

Data Bits [8] Uses UTF8 encoding to map

Parity [None] Unicode chars onto 1 or more

Stop Bits [1] bytes.

Flow Control [None]

VT-UTF8 Combo Key Support [Enabled]

Recorder Mode [Disabled]

Resolution 100x31 [Enabled]

Legacy OS Redirection Resolution [80x24]

Putty KeyPad [VT100] ——: Select Screen

Redirection After BIOS POST

[Always Enable]

11: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C)

2012 American Megatrends,

v' Terminal Type
Optionen: VT100/VT100+/VT-UTF8/ ANSI
v' Bits per second
Optionen: 9600 / 19200 / 38400 / 57600 / 115200
v' Data Bits
Optionen: 7/8
v’ Parity
Optionen: None / Even/ Odd / Mark / Space
v' Stop Bits
Optionen: 1/2
v" Flow Control
Optionen:  None / Hardware RTS/CTS
v VT-UTF8 Combo Key Support
Optionen: Disabled / Enabled
v" Recorder Mode
Optionen: Disabled / Enabled
v" Resolution 100x31
Optionen: Disabled / Enabled
v' Legacy OS Redirection Resolution
Optionen:  80x24 / 80x25
v' Putty KeyPad

Optionen:

Beckhoff New Automation Technology CB1056

Inc.

VT100 / LINUX / XTERMR6 / SCO / ESCN / VT400

Seite 71



Kapitel: BIOS-Einstellungen

4.3.10 Network Stack

Advanced

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced

Network stack
Ipv4 PXE Support
Ipv6e PXE Support

[Enable]
[Enable]
[Enable]

Enable/Disable UEFI network
stack

—<: Select Screen

tl: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

v Network Stack

Optionen: Disabled / Enabled

v" Ipv4 PXE Support

Optionen: Disabled / Enabled

v" Ipv6 PXE Support

Optionen: Disabled / Enabled

Seite 72
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4.3.11 CPU PPM Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Advanced

CPU PPM Configuration Enable/Disable Intel SpeedStep

EIST
Config TDP LOCK

[Enabled]
[
Long duration power limit 0
1
0

Enabled]

Long duration maintained
Short duration power limit

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v EIST
Optionen: Disabled / Enabled

v" Config TDP LOCK
Optionen: Disabled / Enabled

v" Long duration power limit
Optionen:  0-255

v" Long duration power maintained
Optionen: 1-120

v" Short duration power limit
Optionen: 0-255

Beckhoff New Automation Technology CB1056 Seite 73
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4.3.12 Intel(R) GigabitNetworkConnection

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced

PORT CONFIGURATION MENU
» NIC Configuration

Blink LEDs

UEFI Driver:
Adapter PBA:

Chip Type

PCI Device ID
Bus:Device:Function
Link Status

MAC Address

PORT CONFIGURATION INFORMATION

Intel (R) PRO/1000 5.7.06
FFFFFF-0FF

Intel 1210

1532

00:19:00

[Disconnected]
88:88:88:88:87:88

Click to configure the network
device port.

R

Select Screen
Select Item

Enter: Select

+/-:
Fl:
F2:
F3:
F4:
ESC:

Change Opt.
General Help
Previous Values
Optimized Defaults
Save & Exit

Exit

Version 2.15.1236.

v" NIC Configuration

Copyright (C)

Unterment: siehe "NIC Configuration” (Seite 75)

v Blink LEDs

Optionen: keine

v" UEFI Driver:

Optionen: keine
v' Adapter PBA:

Optionen: keine
v" Chip Type

Optionen: keine

v" PCI Device ID
Optionen:  keine

v" PCI Bus:Device:Function

Optionen: keine

v'  Link Status

Optionen:  keine

v" Factory MAC Adress
Optionen: keine

Seite 74
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4.3.12.1 NIC Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Advanced
Link Speed [Auto Neg] Specifies the port speed used
Wake On LAN [Enabled] for the selected boot protocol.

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v' Link Speed
Optionen:  Auto Negotiated / 10Mbps Half / 10Mbps full / 100Mbps Half / 100Mbps Full

v" Wake On LAN
Optionen: Enabled / Disabled

Beckhoff New Automation Technology CB1056 Seite 75
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4.4 Chipset

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Main Advanced Chipset Boot Security Save & Exit

» PCH-IO Configuration System Agent (SA) Parameters
» System Agent (SA) Configuration

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v" PCH-IO Configuration
Untermenu: sieche "PCH-IO Configuration" (Seite 77)

v' System Agent (SA) Configuration
Untermenu: siehe "System Agent (SA) Configuration" (Seite 84)
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4.4.1 PCH-IO Configuration

Kapitel: BIOS-Einstellungen

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Chipset
Intel PCH RC Version 1.5.0.0 PCI Express Configuration
Intel PCH SKU Name QM67 settings
Intel PCH Rev ID 05/B3

» PCI Express Configuration
» USB Configuration
» PCH Azalia Configuration
PCH LAN Controller [Enabled]
LAN1 MAC address 88:88:88:88:87:88
Wake on LAN [Disabled]
Second LAN Controller [Enabled]
LAN2 MAC address 00:01:05:13:90:8F
CLKRUN# Logic [Disabled]
SB Crid [Disabled]

High Precision Event Timer Configuration
High Precision Timer [Enabled]

Restore AC Power Loss [Power On]

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v" Intel PCH RC Version
Optionen: keine

v" Intel PCH SKU Name
Optionen: keine

v" Intel PCH Rev ID
Optionen: keine

v" PCI Express Configuration

Untermenu: siehe "PCI Express Configuration” (Seite 79)

v" USB Configuration
Untermenu: sieche "USB Configuration" (Seite 82)

v" PCH Azalia Configuration

Untermenu: siehe "PCH Azalia Configuration" (Seite 83)

v PCH LAN Controller
Optionen: Disabled / Enabled

v" LAN1 MAC address
Optionen:  keine

v' Wake on LAN
Optionen: Disabled / Enabled

v" Second LAN Controller
Optionen: Disabled / Enabled

v" LAN2 MAC address
Optionen: keine

Beckhoff New Automation Technology CB1056
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v" CLKRUN# Logic
Optionen: Disabled
v SB CRID
Optionen: Disabled / Enabled
v" High Precision Timer
Optionen: Disabled / Enabled
v" Restore AC Power Loss
Optionen: Power Off / Power On / Last State
Seite 78
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4.4.1.1 PCI Express Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Chipset

PCI Express Configuration Enable or disable PCI Express
Clock Gating for each root
PCI Express Clock Gating [Enabled] port.

DMI Link ASPM Control [Enabled]
DMI Link Extended Synch Control [Disabled]
PCIe-USB Glitch W/A [Disabled]
Subtractive Decode [Disabled]

PCI Express Root Port 1

PCI Express Root Port 2

PCI Express Root Port 3

PCI Express Root Port 4

PCIE Port 5 is assigned to LAN
PCIE Port 6 is assigned to LAN2 ——: Select Screen

PCIE Port 7 is assigned to PCIe to PCI Bridge t1: Select Item

» PCI Express Root Port 8 Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

vvyy

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v' PCI Express Clock Gating
Optionen: Disabled / Enabled

v' DMI Link ASPM Control
Optionen: Disabled / Enabled

v DMI Link Extended Synch Control
Optionen: Disabled / Enabled

v" PCle-USB Glitch W/A
Optionen: Disabled / Enabled

v' Subtractive Decode
Optionen: Disabled

v PCI Express Root Port X
Untermenu: siehe "PCI Express Settings" (Seite 80)
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4.41.1.1 PCIExpress Root Port

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Chipset
PCI Express Root Port 2 [Enabled] Control the PCI Express Root
ASPM Support [Auto] Port.
URR [Disabled]
FER [Disabled]
NFER [Disabled]
CER [Disabled]
CTO [Disabled]
SEFE [Disabled]
SENFE [Disabled]
SECE [Disabled]
PME SCI [Enabled]
Hot Plug [Disabled]
PCIe Speed [Auto]
Extra Bus Reserved 0 —<: Select Screen
Reserved Memory 10 t1: Select Item
Prefetchable Memory 10 Enter: Select
Reserved I/0 4 +/-: Change Opt.
Fl: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v" PCI Express Root Port x
Optionen: Disabled / Enabled

v ASPM Support
Optionen: Disabled / LOs /L1 /L0sL1/Auto

v URR
Optionen: Disabled / Enabled

v FER
Optionen: Disabled / Enabled

v" NFER
Optionen: Disabled / Enabled

v CER
Optionen: Disabled / Enabled

v CTO
Optionen: Disabled / Enabled

v SEFE
Optionen: Disabled / Enabled

v SENFE
Optionen: Disabled / Enabled

v SECE
Optionen: Disabled / Enabled

v" PME SCI
Optionen: Disabled / Enabled

Seite 80 Beckhoff New Automation Technology CB1056
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Hot Plug
Optionen: Disabled / Enabled

PCle Speed
Optionen: Auto/ Genl/ Gen2

Extra Bus Reserved
Optionen: 0...7

Reserved Memory
Optionen: 1...20

Prefetchable Memory
Optionen: 1...20

Reserved /O
Optionen: 4/8/12/16/20

Kapitel: BIOS-Einstellungen
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4.4.1.2 USB Configuration

Aptio Setup Utility - Copyright (C)

Chipset

2012 American Megatrends, Inc.

USB Configuration

EHCI1
EHCI2

USB Port #0 Disable
USB Port #1 Disable
USB Port #2 Disable
USB Poer #3 Disable
USB Port #4 Disable
USB Port #5 Disable
USB Port #6 Disable
USB Port #7 Disable
USB Port #8 Disable
USB Port #9 Disable
USB Port #10 Disable

USB Ports Per-Port Disable Control

[Enabled]
[Enabled]

[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]
[Enabled]

Control each of the USB ports
(0~13) disabling.

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

v EHCI1
Optionen: Enabled

v’ EHCI2
Optionen: Enabled

v USB Ports Per-Port Disable Control

Optionen: Disabled / Enabled

v' USB Port #x Disable

Optionen: Disabled / Enabled

Seite 82
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4.4.1.3 PCH Azalia Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Chipset
PCH Azalia Configuration Control Detection of the
Azalia device.

Azalia [Auto] Disabled = Azalia will be
Azalia PME [Disabled] unconditionally disabled
Azalia Internal HDMI Codec [Enabled] Enabled = Azalia will be

Azalia HDMI codec Port B [Disabled] unconditionally Enabled
Azalia HDMI codec Port C [Disabled] Auto = Azalia will be enabled
Azalia HDMI codec Port D [Enabled] if present, disabled otherwise.

——: Select Screen

t11: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v Azalia
Optionen: Disabled / Enabled / Auto

v' Azalia PME
Optionen: Disabled / Enabled

v' Azalia Internal HDMI Codec
Optionen: Disabled / Enabled

v" Azalia HDMI codec Port X
Optionen: Disabled / Enabled
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Chipset

4.4.2 System Agent (SA) Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Chipset

System Agent Bridge Name
System Agent RC Version

CHAP Device (B0:D7:F0)
Thermal Device (B0:D4:F0)
Enable NB CRID

BDAT ACPI Table Support
C-State Pre-Wake

» Graphics Configuration
» NB PCIe Configuration

SandyBridge
1.5.0.0

[Enabled]

[Disabled]
[Disabled]
[Disabled]

Enable or disable SA CHAP
Device.

—<: Select Screen

tl: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

v' System Agent Bridge Name

Optionen: keine

v' System Agent RC Version
Optionen: keine

v" CHAP Device (B0:D7:FO0)

Optionen: Disabled / Enabled

v" Thermal Device (B0:D4:F0)

Optionen: Disabled / Enabled

v Enable NB CRID

Optionen: Disabled / Enabled

v BDAT ACPI Table Support

Optionen: Disabled / Enabled

v C-State Pre-Wake

Optionen: Disabled / Enabled

v' Graphics Configuration

Copyright (C)

2012 American Megatrends, Inc.

Unterment: siehe "Graphics Configuration” (Seite 85)

v NB PCle Configuration

Untermenu: siehe "NB PCle Configuration" (Seite 87)

Seite 84
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4.4.2.1 Graphics Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Chipset
Graphics Configuration Graphics turbo IMON current
IGFX VBIOS Version 2137 values supported (14-31)
IGfx Frequency 650 MHz
Graphics Turbo IMON Current 31
Primary Display [Auto]
Internal Graphics [Auto]
GTT Size [2MB]
Aperture Size [256MB]
DVMT Pre-Allocated [64M]
DVMT Total Gfx Mem [256M]
Gfx Low Power Mode [Disabled]

» LCD Control

——: Select Screen

11: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v IGFX VBIOS Version
Optionen: keine

v IGFX Frequency
Optionen: keine

v" Graphics Turbo IMON Current
Optionen: 14...31

v' Primary Display
Optionen: Auto / IGFX / PEG / PCI

v" Internal Graphics
Optionen: Auto / Disabled / Enabled

v GTT Size
Optionen: 1MB/2MB

v' Aperture Size
Optionen: 128MB/ 256MB /512MB

v' DVMT Pre-Allocated
Optionen:  32M/ 64M ... 480M / 512M / 1024M

v DVMT Total Gfx Mem
Optionen: 128M / 256M / MAX

v' Gfx Low Power Mode
Optionen: Disabled / Enabled

v" LCD Control
Untermenu: siehe "LCD Control" (Seite 86)
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44211 LCD

Control

Aptio Setup Utility - Copyright
Chipset

(C) 2012 American

Megatrends, Inc.

LCD Control

Primary IGFX B
Secondary IGFEX
LCD Panel Type
Spread Spectru
ALS Support

oot Display
Boot Display

CRT]

m clock Chip Off]

[
[Disabled]
[VBIOS Default]
[

[

Disabled]

Select the Video Device which
will be activated during POST.
This has no effect if external
graphics present.

Secondary boot display
selection will appear based on
your selection.

VGA modes will be supported
only on primary display

—<: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

v" Primary IGFX Boot Display
VBIOS Default/ CRT / EFP / LFP / EFP3/ EFP2 / LFP2

Optionen:

v" Secondary IGFX Boot Display
VBIOS Default/ CRT / EFP / LFP / EFP3 / EFP2 / LFP2

Optionen:

v' LCD Panel Type
VBIOS Default / 640x480 LVDS ...1920x1080 LVDS / 2048x1536 LVDS

Optionen:

v' Spread Spe
Optionen:

ctrum Clock Chip
Off / Hardware / Software

v" ALS Support

Optionen:

Seite 86

Disabled / Enabled

Copyright (C)
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4.4.2.2 NB PCle Configuration

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Chipset
Configure PEGO BO:D1:FO

PEGO Not Present Genl-Gen3

PEGO - Gen X [Auto]

PEGO ASPM [Auto]
Enable PEG [Auto]
Detect Non-Compliance Device [Disabled]
De-Emphasis Control [-3.5 dB]
PEG Sampler Calibrate [Auto]
Swing Control [Full]
Gen3 Equalization [Enabled]

Gen3 Eg Phase 2 [Disabled]

I A A N >

» PEG Gen3 Root Port Preset Value for each Lane ——: Select Screen
» PEG Gen3 Endpoint Preset Value each Lane t1: Select Item
» PEG Gen3 Endpoint Hint Value each Lane Enter: Select
Gen3 Eqg Preset Search [Enabled] +/-: Change Opt.
Always re-search Gen3 Eg Preset [Disabled] Fl: General Help
Preset Search Dwell Time 100 F2: Previous Values
Timing Margin Steps 2 F3: Optimized Defaults
Timing Start Margin 15 F4: Save & Exit
Voltage Margin Steps 2 ESC: Exit
Voltage Start Margin 20
Favor Timing Margin [Disabled]
PEG Link Disabled [Disabled]
Fast PEG Init [Enabled] v

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v PEGn - Gen X
Optionen: Auto/ Genl/ Gen2/ Gen3

v PEGn ASPM
Optionen: Disabled / Auto / ASPM LOs / ASPM L1/ ASPM LOsL1

v Enable PEG
Optionen: Disabled / Enabled / Auto

v" Detect Non-Compliance Device
Optionen: Disabled / Enabled

v' De-emphasis Control
Optionen: -6dB/-3.5dB

v' PEG Sampler Calibrate
Optionen:  Auto / Disabled / Enabled

v" Swing Control
Optionen: Reduced / Half / Full

v Gen3 Equalization
Optionen: Disabled / Enabled

v Gen3 Eq Phase 2
Optionen:  Auto / Enabled / Disabled

v" Gen3 Root Port Preset Value for each Lane
Untermenu: siehe "PEG Gen3 Root Port Preset Value for each Lane" (Seite 89)

v PEG Gen3 Endpoint Preset Value for each Lane
Untermenii: siehe "PEG Gen3 Endpoint Preset Value each Lane" (Seite 90)
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v PEG Gen3 Endpoint Hint Value for each Lane
Untermenu: siehe "PEG Gen3 Endpoint Hint Value each Lane" (Seite 91)

v" Gen3 Eq Preset Search
Optionen: Enabled / Disabled

v' Always re-search Gen3 Eq Preset
Optionen: Enabled / Disabled

v Preset Search Dwell Time
Optionen: 0-65535

v Timing Margin Steps
Optionen:  1-255

v Timing Start Margin
Optionen:  4-255

v" Voltage Margin Steps
Optionen:  1-255

v' Voltage Start Margin
Optionen: 4-255

v' Favor Timing Margin
Optionen: Enabled / Disabled

v" PEG Link Disabled
Optionen: Disabled / Enabled

v' Fast PEG Init
Optionen: Disabled / Enabled

v RXCEM Loop back
Optionen: Disabled / Enabled

v RXCEM Loop back lane
Optionen: Lane 0...15

v" PCle Gen3 RxCTLEp Setting
Optionen: 0...15
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4.42.21 PEG Gen3 Root Port Preset Value for each Lane

Aptio Setup Utility - Copyright

(C)

2012 American Megatrends, Inc.

v" Gen3 Root Port Preset Value for each Lane
Optionen:

1.11

Chipset
PEG Gen3 Root Port Preset Value for each Lane Lane 0 Root port preset value

for Gen3 Equalization.

Gen3 Root Port Preset Lane 0 8

Gen3 Root Port Preset Lane 1 8

Gen3 Root Port Preset Lane 2 8

Gen3 Root Port Preset Lane 3 8

Gen3 Root Port Preset Lane 4 8

Gen3 Root Port Preset Lane 5 8

Gen3 Root Port Preset Lane 6 8

Gen3 Root Port Preset Lane 7 8

Gen3 Root Port Preset Lane 8 8

Gen3 Root Port Preset Lane 9 8

Gen3 Root Port Preset Lane 10 8

Gen3 Root Port Preset Lane 11 8 ——: Select Screen

Gen3 Root Port Preset Lane 12 8 t1: Select Item

Gen3 Root Port Preset Lane 13 8 Enter: Select

Gen3 Root Port Preset Lane 14 8 +/-: Change Opt.

Gen3 Root Port Preset Lane 15 8 Fl: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.
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Chipset

4.4.2.2.2 PEG Gen3 Endpoint Preset Value each Lane

v" Gen3 Endpoint Preset Value each Lane
Optionen:

0.11

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Chipset
PEG Gen3 Endpoint Preset Value each Lane Lane 0 End point preset value

for Gen3 Equalization.

Gen3 Root Port Preset Lane 0 7

Gen3 Root Port Preset Lane 1 7

Gen3 Root Port Preset Lane 2 7

Gen3 Root Port Preset Lane 3 7

Gen3 Root Port Preset Lane 4 7

Gen3 Root Port Preset Lane 5 7

Gen3 Root Port Preset Lane 6 7

Gen3 Root Port Preset Lane 7 7

Gen3 Root Port Preset Lane 8 7

Gen3 Root Port Preset Lane 9 7

Gen3 Root Port Preset Lane 10 7

Gen3 Root Port Preset Lane 11 7 ——: Select Screen

Gen3 Root Port Preset Lane 12 7 t1: Select Item

Gen3 Root Port Preset Lane 13 7 Enter: Select

Gen3 Root Port Preset Lane 14 7 +/-: Change Opt.

Gen3 Root Port Preset Lane 15 7 Fl: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

Seite 90

Beckhoff New Automation Technology CB1056



Chipset

Kapitel: BIOS-Einstellungen

4.4.2.2.3 PEG Gen3 Endpoint Hint Value each Lane

Aptio Setup Utility - Copyright

Chipset

(C) 2012 American Megatrends, Inc.

PEG

Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3
Gen3

Gen3

Root
Root
Root
Root
Root
Root
Root
Root
Root
Root
Root
Root
Root
Root
Root
Root

Endpoint Hint Value each Lane

Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port
Port

Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset
Preset

Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane
Lane

W JoN U WN PO

NDNODNNDDNDNDNDNDDNDNDNDNDNDNDNDND

for

Lane 0 End Point Hint value

Gen3 Equalization.

E

Fl:
F2:
F3:
F4:

ESC:

Select Screen
Select Item

Enter: Select
+/=:

Change Opt.
General Help
Previous Values
Optimized Defaults
Save & Exit

Exit

Version 2.15.1236. Copyright

(C)

2012 American Megatrends, Inc.

v PEG Gen3 Endpoint Hint Value each Lane
Optionen:

0.11

Beckhoff New Automation Technology CB1056
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Chipset

4.42.2.4 PCle Gen3 RxCTLEp Setting

Aptio Setup Utility - Copyright

Chipset

()

2012 American

Megatrends, Inc.

PCIe Gen3 RxCTLEp Setting

Select the Video Device which
will be activated during POST.

PCIe Gen3 RxCTLEp Setting 0 8 This has no effect if external
PCIe Gen3 RxCTLEp Setting 1 8 graphics present.
PCIe Gen3 RxCTLEp Setting 2 8 Secondary boot display
PCIe Gen3 RxCTLEp Setting 3 8 selection will appear based on
PCIe Gen3 RxCTLEp Setting 4 8 your selection.
PCIe Gen3 RxCTLEp Setting 5 8 VGA modes will be supported
PCIe Gen3 RxCTLEp Setting 6 8 only on primary display
PCIe Gen3 RxCTLEp Setting 7 8
—<: Select Screen
t1: Select Item
Enter: Select
+/-: Change Opt.
Fl: General Help
F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit
ESC: Exit
Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v" PCle Gen3 RXxCTLEp Setting x

Optionen: 0..15

Seite 92
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4.5 Boot

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Main Advanced Chipset Boot Security Save & Exit

Boot Configuration Number of 1/10 sec. to wait
Setup Prompt Timeout 5 for setup activation key. 0
Bootup NumLock State [On] means no wait.
Full Screen Logo [Enabled]
Fast Boot [Enabled]

Skip VGA [Disabled]

Skip USB [Disabled]

Skip PS2 [Disabled]
CSM16 Module Version 07.69
GateA20 Active [Upon Request]

INT19 Trap Response [Postponed] ——: Select Screen
Boot mode select [UEFI] 11: Select Item

Enter: Select

FIXED BOOT ORDER Priorities +/-: Change Opt.
Boot Option #1 [UEFI Hard Disk] Fl: General Help
Boot Option #2 [UEFI CD/DVD] F2: Previous Values
Boot Option #3 [UEFI USB Hard Disk] F3: Optimized Defaults
Boot Option #4 [UEFI USB CD/DVD] F4: Save & Exit
Boot Option #5 [UEFI USB Stick] ESC: Exit
Boot Option #6 [UEFI USB Floppy]
Boot Option #7 [UEFI Network]

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v/ Setup Prompt Timeout
Optionen:  0...65535 [x 1/10 sec.]

v' Bootup NumLock State
Optionen:  On/ Off

v" Full Screen Logo
Optionen: Disabled / Enabled

v" Fast Boot
Optionen: Disabled / Enabled

v' Skip VGA
Optionen: Disabled / Enabled

v' Skip USB
Optionen: Disabled / Enabled

v' Skip PS2
Optionen: Disabled / Enabled

v" CSM16 Module Version
Optionen: keine

v GateA20 Active
Optionen:  Upon Request / Always

v" INT9 Trap Response
Optionen: Immediate / Postponed

v Boot mode select
Optionen: Legacy / UEFI/ DUAL
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v Fixed Boot Order Priorities
Optionen: Reihenfolge der Boot-Devices tberprifen/andern

v' Boot Option Priorities
Optionen: Reihenfolge der Boot-Devices tberprifen/andern

v CSM Parameters
Untermenu: siehe "CSM Parameters” (Seite 95)
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451 CSM Parameters

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.
Main Advanced Chipset BOOT Security Save & Exit

Launch CSM [Always] Controls the execution of UEFI
Boot option filter [UEFI only] and Legacy PXE OpROM

Launch PXE OpROM policy [Enable]

Launch Storage OpROM policy [Legacy only]
Launch Video OpROM policy [Legacy only]

Other PCI device ROM priority [Legacy OpROM]

——: Select Screen

t11: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v Launch CSM
Optionen: Enabled / Disabled

v' Boot option filter
Optionen: UEFI and Legacy / Legacy only / UEFI only

v" Launch PXE OpROM policy
Optionen: Disable / Enable

v' Launch Storage OpROM policy
Optionen: Do not launch / UEFI only / Legacy only

v" Launch Video OpROM policy
Optionen: Do not launch / UEFI only / Legacy only

v' Other PCI device ROM priority
Optionen: UEFI OpROM / Legacy OpROM
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4.6 Security

Aptio Setup Utility - Copyright (C) 2012 American

Main Advanced Chipset

Boot

Security Save & Exit

Megatrends, Inc.

The password length must be
in the following range:
Minimum length

Maximum length

Administrator Password

UEFI Secure Boot Management
Secure Boot control

» Secure Boot Policy

» Key Management

[Enabled]

Set Administrator Password.
When set, this password has to
be entered to enter setup

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236. Copyright (C) 2012 American Megatrends, Inc.

v Administrator Password
Optionen:

v Secure Boot control
Optionen:

v" Secure Boot Policy
Untermenii: siehe

v' Key Management
Untermend: siehe

Seite 96

Eingabetaste driicken

Disabled / Enabled

"Secure Boot Policy" (Seite 97)

"Key Management” (Seite 98)

Security
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4.6.1 Secure Boot Policy

Aptio Setup Utility - Copyright (C)

2012 American
Security

Kapitel: BIOS-Einstellungen

Megatrends, Inc.

Internal FV
Option ROM
Removable Media
Fixed Media

Always Execute]
Deny Execute]
Deny Execute]
Deny Execute]

[
[
[
[

Image Execution Policy on
Security Violation. Image load
device path

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

v' Internal FV
Optionen: Always Execute

v Option ROM
Optionen:
User

v" Removable Media
Optionen:
User

v Fixed Media
Optionen:
User

Copyright (C)

Beckhoff New Automation Technology CB1056

2012 American Megatrends, Inc.

Always Execute / Always Deny / Allow Execute / Defer Execute / Deny Execute / Query

Always Execute / Always Deny / Allow Execute / Defer Execute / Deny Execute / Query

Always Execute / Always Deny / Allow Execute / Defer Execute / Deny Execute / Query
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4.6.2 Key Management

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Security
System Mode Setup Launches the Filebrowser to
Secure Boot Mode Disabled set the Platform Key from file
Platform Key (PK) NOT INSTALLED
» Set PK from File
» Get PK to File
» Delete the PK
Key Exchange Key Database (KEK) NOT INSTALLED
» Set KEK from File
» Get KEK to File
» Delete the KEK
» Append an entry to KEK
Authorized Signature Database (DB) NOT INSTALLED
» Set DB from File —: Select Screen
» Get DB to File tl: Select Item
» Delete the DB Enter: Select
» Append an entry to DB +/-: Change Opt.
Forbidden Signature Database (DBX) NOT INSTALLED Fl: General Help
» Set DBX from File F2: Previous Values
» Get DBX to File F3: Optimized Defaults
» Delete the DBX F4: Save & Exit
» Append an entry to DBX ESC: Exit
Manage All Factory Keys (PK,KEK, DB, DBX)
Install Factory Defaults

Version 2.15.1236.

v’ System Mode
Optionen: keine

v Secure Boot Mode
Optionen: keine

v Set PK from File

Copyright (C)

Optionen: Eingabetaste driicken

v" Get PK to File

Optionen: Eingabetaste driicken

v" Delete the PK

Optionen: Eingabetaste driicken

v Set KEK from File

Optionen: Eingabetaste driicken

v" Get KEK to File

Optionen: Eingabetaste driicken

v Delete the KEK

Optionen:  Eingabetaste driicken

v" Append an entry to KEK

Optionen: Eingabetaste driicken

v Set DB from File

Optionen: Eingabetaste driicken

v Get DB to File

Optionen: Eingabetaste driicken

Seite 98
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Delete the DB
Optionen:  Eingabetaste driicken

Append an entry to DB
Optionen: Eingabetaste driicken

Set DBX from File
Optionen: Eingabetaste driicken

Get DBX to File
Optionen: Eingabetaste driicken

Delete the DBX
Optionen:  Eingabetaste driicken

Append an entry to DBX
Optionen:  Eingabetaste driicken

Install Factory Defaults
Optionen: Eingabetaste driicken

Kapitel: BIOS-Einstellungen
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4.7 Save & Exit

Aptio Setup Utility - Copyright
Main Advanced Chipset Boot Security Save

Save & Exit

(C) 2012 American Megatrends, Inc.
& Exit

Save Changes and Reset
Discard Changes and Reset

Restore Optimized Defaults
Save as User Defaults
Restore User Defaults

Boot Override
IBA GE Slot 00C8 v1381

Reset the system after saving
the changes.

——: Select Screen

t1: Select Item

Enter: Select

+/-: Change Opt.

Fl: General Help

F2: Previous Values
F3: Optimized Defaults
F4: Save & Exit

ESC: Exit

Version 2.15.1236.

v' Save Changes and Reset

Copyright (C)

Optionen: Eingabetaste driicken

v" Discard Changes and Reset

Optionen: Eingabetaste driicken

v Restore Defaults

Optionen: Eingabetaste driicken

v" Save as User Defaults

Optionen: Eingabetaste driicken

v Restore User Defaults

Optionen: Eingabetaste driicken

v" Boot Override

Optionen: Eingabetaste driicken

v" IBA GE Slot 00C8 v1381
Optionen: keine
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4.8 BIOS-Update

Wenn ein Update des BIOS vorgenommen werden soll, dann wird hierzu das Programm ,DecdFlsh*
sowie ein bootfahiges Medium mit der aktuellsten BIOS-Version benutzt. Dabei ist es wichtig, dass das
Programm aus einer DOS-Umgebung ohne einen virtuellen Speichermanager wie zum Beispiel
LEMM386.EXE" gestartet wird. Sollte ein solcher Speichermanager geladen sein, wird das Programm mit
einer Fehlermeldung abbrechen oder einen Absturz verursachen.

DecdFlsh ist ein Programm zum automatischen Update des BIOS auf allen Boards mit AMI-BIOS. Alle
Dateien aus dem zip-Verzeichnis missen in ein Verzeichnis entpackt werden. Von dort wird

DecdFlsh Bios-Dateiname

aufgerufen. Der Name der BIOS-Datei und deren Lange werden Uberprift. Das BIOS wird nun
programmiert.

Wahrend des Flash-Vorgangs darf das System auf keinen Fall unterbrochen werden, da sonst das Update
abbricht und anschlieRend das BIOS auf dem Board zerstort ist. Der Flash-Vorgang dauert etwa 75
Sekunden. Das erforderliche Firmware-Update erfolgt automatisch.

A ACHTUNG

Wenn das BIOS-Update fehlerhaft durchgefiihrt wird, kann das Board dadurch unbenutzbar werden.
Deshalb sollte ein BIOS-Update nur gemacht werden, wenn die Korrekturen/Erganzungen, die die neue
BIOS-Version mitbringt, auch wirklich benétigt werden.

A ACHTUNG

Vor einem geplanten BIOS-Update muss unbedingt sichergestellt werden, dass die BIOS-Datei, die neu
eingespielt werden soll, wirklich fir genau dieses Board und fiir genau diese Boardversion herausgegeben
wurde. Wenn eine ungeeignete Datei verwendet wird, dann fuhrt dies unweigerlich dazu, dass das Board
anschlieRend nicht mehr startet.
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5 Mechanische Zeichnung

5.1 Leiterplatte: Bohrungen
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5.2 Leiterplatte: Pin-1-Abstande

Die folgende Zeichnung wird insbesondere fiir die Anfertigung von Prifadaptern bendtigt.
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5.3 Leiterplatte: Die Center

Aus der folgenden Zeichnung sind die Mittelpunktskoordinaten folgender Elemente zu entnehmen: 1) CPU
und PCH, 2) Bohrl6écher fir die Kuhlkdrper und 3) 10-Stecker der Riickwandblende.
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Elektrische Daten

6 Technische Daten

6.1 Elektrische Daten

Spannungsversorgung:
Board:
RTC:
Stromverbrauch:
Board:
RTC:

6.2 Umgebungsbedingungen

Temperaturbereich:
Operating:
Lagerung:
Versand:

Temperaturanderungen:
Operating:
Lagerung:
Versand:

Relative Luftfeuchte:
Operating:
Lagerung:
Versand:

Stol3:
Operating:
Lagerung:
Versand:

Vibrationen:
Operating:

Lagerung:

Versand:

A ACHTUNG

Kapitel: Technische Daten

ATX inkl. 2x2pin-12V-Stecker
>= 3 Volt

typische Leistungsaufnahme unter Last: 10W
(ohne CPU und Erweiterungskarten)
<=10pA

0°C bis +60°C (erw. Temperaturbereich auf Anfrage)
-25°C bis +85°C
-25°C bis +85°C, fur verpackte Boards

0,5°C pro Minute, 7,5°C in 30 Minuten
1,0°C pro Minute
1,0°C pro Minute, fur verpackte Boards

5% bis 85% (nicht kondensierend)
5% bis 95% (nicht kondensierend)
5% bis 100% (nicht kondensierend), fur verpackte Boards

150m/s®, 6ms
400m/s’, 6ms
400m/s?, 6ms, fiur verpackte Boards

10 bis 58Hz, 0,075mm Amplitude

58 bis 500Hz, 10m/s’

5 bis 9Hz, 3,5mm Amplitude

9 bis 500Hz, 10m/s’

5 bis 9Hz, 3,5mm Amplitude

9 bis 500Hz, 10m/s?, fur verpackte Boards

Die Angaben zu StoR3- und Vibrationsfestigkeit beziehen sich auf das reine Motherboard ohne Kiihlkorper,

Speicherriegel, Verkabelungen usw.
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6.3 Thermische Spezifikationen

Das Board ist spezifiziert fur einen Umgebungstemperaturbereich von 0°C bis +60°C (erw.
Temperaturbereich auf Anfrage). Zusétzlich muss darauf geachtet werden, dass die Temperatur des
Prozessor-Dies 100°C nicht Uberschreitet. Hierfir muss ein geeignetes Kiihlkonzept realisiert werden, das
sich an der maximalen Leistungsaufnahme des Prozessors/Chipsatzes orientiert. Zu beachten ist dabei
auch, dass eventuell vorhandene Kontroller im Kihlkonzept Beriicksichtigung finden. Die
Leistungsaufnahme dieser Bausteine liegt unter Umstanden in der gleichen GréRenordnung wie die
Leistungsaufnahme des stromsparenden Prozessors.

Das Board ist durch geeignete Bohrungen fur den Einsatz moderner Kiihl-Losungen vorbereitet. Wir haben
eine Reihe von kompatiblen Kiihl-Komponenten im Programm. Ihr Distributor berét Sie gerne bei der
Auswahl geeigneter Lésungen.

A ACHTUNG

Es liegt im Verantwortungsbereich des Endkunden, dass die Die-Temperatur des Prozessors 100°C nicht
tiberschreitet! Eine dauerhafte Uberhitzung kann das Board zerstéren!

Fur den Fall, dass die Temperatur 100°C tberschreitet, muss die Umgebungstemperatur reduziert werden.
Unter Umstanden muss flr eine ausreichende Luftzirkulation Sorge getragen werden.
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7 Support und Service

Beckhoff und seine weltweiten Partnerfirmen bieten einen umfassenden Support und Service, der eine
schnelle und kompetente Unterstiitzung bei allen Fragen zu Beckhoff-Produkten und -Systemlésungen zur
Verfugung stellt.

7.1 Beckhoff-Support

Der Support bietet Ihnen einen umfangreichen technischen Support, der Sie nicht nur bei dem Einsatz
einzelner Beckhoff-Produkte, sondern auch bei weiteren umfassenden Dienstleistungen unterstitzt:

o weltweiter Support
o Planung, Programmierung und Inbetriebnahme komplexer Automatisierungssysteme
o umfangreiches Schulungsprogramm fiir Beckhoff-Systemkomponenten

Hotline: +49(0)5246/963-157
Fax: +49(0)5246/963-9157
E-Mail: support@beckhoff.com

7.2 Beckhoff-Service

Das Beckhoff-Service-Center unterstiitzt Sie rund um den After-Sales-Service:

Vor-Ort-Service
Reparaturservice
Ersatzteilservice
Hotline-Service

Hotline: +49(0)5246/963-460
Fax: +49(0)5246/963-479
E-Mail: service@beckhoff.com

@)
@)
@)
@)

7.3 Beckhoff-Firmenzentrale
Beckhoff Automation GmbH

Eiserstr. 5

33415 Verl

Deutschland
Telefon: +49(0)5246/963-0
Fax: +49(0)5246/963-198
E-Mail: info@beckhoff.de
Web www.beckhoff.de

Weitere Support- und Serviceadressen finden Sie auf unseren Internetseiten unter http://www.beckhoff.de.
Dort finden Sie auch weitere Dokumentationen zu Beckhoff-Komponenten.
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| Anhang: Post-Codes

Wahrend der Bootphase generiert das BIOS eine Reihe von Statusmeldungen (sog. "POST-Codes"), die
mit Hilfe eines geeigneten Lesegerates (POST-Code-Karte) ausgegeben werden kénnen. Die Bedeutung
der POST-Codes wird in dem Dokument "Aptio™ 4.x Status Codes" von American Megatrends® erldutert,
das auf der Webseite http://www.ami.com erhdltlich ist. Zusatzlich werden die folgenden
OEM-POST-Codes ausgegeben:

Code Beschreibung
87h BIOS-API gestartet

88h PCA9535 gestartet

89h PWRCTRL-Firmware gestartet
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Il Anhang: Ressourcen

|IO-Bereich

Die verwendeten Ressourcen sind abhéngig von der Setup-Einstellung.

Bei den aufgefiihrten Bereichen handelt es sich um feststehende 10-Bereiche die durch AT-Kompatibilitat
gegeben sind. Es werden weitere 10-Bereiche benutzt, die durch die Plug&Play-Funktion des BIOS
wahrend der Boot-Phase dynamisch vergeben werden.

Adresse Funktion
0-FF Reservierter |0-Bereich fiir das Board
170-17F
1F0-1F7
278-27F
2E8-2EF COM4
2F8-2FF COM2
370-377
378-37F
3BC-3BF
3E8-3EF COM3
3F0-3F7
3F8-3FF COM1

Memory-Bereich

Die verwendeten Ressourcen sind abhéngig von der Setup-Einstellung.
Wenn der gesamte Bereich durch Option-ROM'’s belegt wird, konnen diese Funktionen nicht mehr aktiviert
werden bzw. funktionieren nicht mehr.

Adresse Funktion
A0000-BFFFF VGA-RAM
C0000-CFFFF VGA-BIOS
DO000-E7FFF AHCI BIOS / RAID / PXE (falls verfiigbar)
E8000-FFFFF System-BIOS

Interrupt

Die verwendeten Ressourcen sind abhéngig von der Setup-Einstellung.

Die aufgefuihrten Interrupts und deren Benutzung sind durch die AT-Kompatibilitat gegeben.

Wenn Interrupts exklusiv auf der ISA-Seite zur Verfligung stehen missen, sind diese durch das
BIOS-Setup zu reservieren. Auf der PCI-Seite ist die Exklusivitat nicht gegeben und auch nicht mdoglich.

Adresse Funktion
IRQO Timer
IRQ1 PS/2 Tastatur
IRQ2 (9) COM3
IRQ3 COM1
IRQ4 COM2
IRQ5 COM4
IRQ6
IRQ7
IRQ8 RTC
IRQ9
IRQ10
IRQ11
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Adresse

Funktion

IRQ12 PS/2 Maus

IRQ13 FPU

IRQ14

IRQ15

PCI-Devices

Die hier aufgeftihrten PCI-Devices sind alle auf dem Board vorhandenen inklusive der, die durch das BIOS
erkannt und konfiguriert werden. Durch Setup-Einstellungen des BIOS kann es vorkommen, dass
verschiedene PCI-Devices oder Funktionen von Devices nicht aktiviert sind. Wenn Devices deaktiviert
werden, kann sich dadurch bei anderen Devices die Bus-Nummer andern.

AD INTA REQ Bus Dev. Fkt. Kontroller / Slot

- - 0 0 0 Host Bridge 1D0104h
A - 0 2 0 VGA Graphics ID0116h
A - 0 25 0 LAN QM67 ID1502h
A - 0 26 0 USB EHCI Controller #2 QM67 ID1C2Dh
A - 0 27 0 HDA Controller QM67 ID1C20h
A - 0 28 0 PCI Express Port 1 QM67 ID1C10h
B - 0 28 1 [PCI Express Port 2 QM67 ID1C12h]
C - 0 28 2 [PCI Express Port 3 QM67 ID1C14h]
D - 0 28 3 [PCI Express Port 4 QM67 ID1C16h]
A - 0 28 4 [PCI Express Port 5 QM67 ID1C18h]
B - 0 28 5 PCI Express Port 6 QM67 ID1C1Ah
C - 0 28 6 PCI Express Port 7 QM67 ID1C1Ch
D - 0 28 7 [PCI Express Port 8 QM67 ID1C1Eh]
A - 0 29 0 USB EHCI Controller #1 QM76 ID1C26h
- - 0 31 0 ISA Bridge QM67 ID1C4Fh
B - 0 31 2 SATA Interface #1 QM67 ID1CO03h
C - 0 31 3 SMBus Interface QM67 ID1C22h
A - m 0 0 LAN 82547L ID10D3h
A - n 0 0 PCle-to-PCI Bridge IDE111h

20 A 0 0 4 0 PCI Slot 1

21 B 1 0 5 0 PCI Slot 2

22 C 2 0 6 0 PCI Slot 3

Ressourcen: SMB-Devices

Die folgende Tabelle listet die reservierten SM-Bus-Device-Adressen in 8-Bit-Schreibweise auf. Diese
Adressbereiche dirfen auch dann nicht von externen Geraten benutzt werden, wenn die in der Tabelle
zugeordnete Komponente auf dem Motherboard gar nicht vorhanden ist.

Adresse Funktion
10-11 Standard-Slave-Adresse
40-41 GPIO
60-61 Reserviert vom BIOS
70-73 POST-Code Output
88-89 Vom BIOS definierte Slave-Adresse
AO0-Al DIMM 1
A2-A3 DIMM 2
Ad-AF Reserviert vom BIOS
BO-BF Reserviert vom BIOS
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Adresse

Funktion

D2-D3

Clock
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